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اهداف رفتاری:
پس از آموزش این واحد کار از فراگیر انتظار می‌رود:

1. امکانات سیستم عامل ویندوز را شرح دهد.

2. ویندوز را تعریف کند.

3. پنجره و اجزای آن را نام ببرد.

4. مفهوم Icon  را شرح دهد.

5. مدیریت File وFolder را انجام دهد.

6. روش جستجو File و........را انجام دهد.

Format .7 کردن یک درایو، حافظه و ........ را انجام دهد.

هدف کلی : به کارگیری کامپیوتر و مدیریت فایل‌ها

1. چگونه می‌توان وارد محیط کار ویندوز شد؟

2. اجزای اصلی کامپیوتر را نام برده و وظیفه هر کدام را شرح دهید؟

3. نحوه روشن و خاموش کردن کامپیوتر را توضیح دهید؟

پیش آزمون:)10 دقیقه(
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)operationfg system(تعریف سیستم عامل

مجموعه‌ای از برنامه‌ها که موجب راه‌اندازی و اســتفاده از کامپیوتر می‌شود"سیستم عامل"یا"os"گویند. سیستم 
عامل مهم‌ترین نرم‌افزار در کامپیوتر است.

پس از روشن کردن کامپیوتر اولین نرم افزاری که مشاهده می‌شود سیستم عامل بوده و آخرین نرم‌افزار قبل از
خاموش کردن نیز سیستم عامل است.

سیستم عامل نرم‌افزاریست که ارکان اجرای تمامی برنامه‌های کامپیوتری را فراهم می آورد.

وظایف سیستم عامل

سیستم عامل دو وظیفه )هدف( اصلی دارد:

1. سیستم عامل استفاده از کامپیوتر را ساده می‌سازد.

مثلا کاربر یا برنامه نویس بدون درگیر شــدن با مسائل سخت افزاری براحتی می‌تواند فایلی را به روی حافظه 
ذخیره و حذف کند.

2. سیســتم عامل باعث استفاده بهینه و سودمند از منابع کامپیوتر می‌گردد و آن‌ها را مدیریت می‌کند منظور 
از منابع، پرونده‌ها، حافظه‌ها، دیسک‌ها، موس، چاپگرها و غیره می‌باشد.

بطور کلی وظیفه سیستم عامل مدیریت اجزای کامپیوتر و سهولت استفاده از آن می‌باشد.

xp معرفی ویندوز -  

ویندوزxp یکی از سیستم عامل‌هایی می‌باشد که در سال 2001 توسط شرکت میکرو سافت در دو نسخه 1. 
منوی کار )میز کار( ویندوز کاملاً جذاب و ساده گردیده و منوی شروع به نحوکارآمدتری تنظیم شده است. 

2.چندین کاربر می‌توانند به صورت همزمان و مجزا از یکدیگر با یک سیستم عامل کار کنند.

3. نــرم افزارهای جانبی جدید نظیر DVD player ونرم افزار کپی،media player CD با ویژ‌گی‌های جدید 
اضافه شده است.
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4. قابلیت پشتیبانی از سیستم فایل NTFS برای افزایش امکانات امنیتی را دارد

5. نصب و ارتقاءِ و پشتیبانی ویندوز و سایر برنامه‌ها از طریق اینترنت آسانتر شده است 

  6. در تمامی پنجره های آن قسمتی بعنوان راهنمایی و کمک )help( به کاربر در نظر گرفته شده است.

)MOUSE(اصول کار با دکمه‌های ماوس -

ماوس وسیله‌ای است جانبی که برای کار در محیط‌های گرافیکی مثل ویندوز بسیار مفید و مؤثر است. ماوس با 
شکل‌های متفاوتی ظاهر می‌شود ولی عملکرد دکمه‌های آن یکسان و استاندارد است.

وقتی ماوس به کامپیوتر متصل است اشاره‌گر )Pointer(ماوس بر روی صفحه نمایش ظاهر می‌شود.

- برای آشنایی با دکمه‌های ماوس کارهای زیر را انجام می‌دهیم:

اشاره کردن :

موس را بر روی میز کار جابجا کرده و اشاره‌گر را بر روی شکلی قرار می‌دهیم.

Click:کلیک کردن

اگر بر روی عنصری که با موس به آن اشاره کردیم یک بار کلیک سمت چپ موس را فشار دهیم تا شکل مزبور 
انتخاب شود )Highlight( کلیک یا Select گویند.



12

Clickکلیک

یک بار فشردن و رها کردن دکمه سمت چپ موس را کلیک گویند.   

Double Clickدابل کلیک

دو بار فشردن متوالی و رها کردن دکمه سمت چپ ماوس را گویند.

)Rright Click(راست کلیک

با یک بار فشردن و رها کردن دکمه سمت راست بر روی شکل منوی خصوصیات               

 شکل نمایان می‌شود این عمل را راست کلیک گویند.

)Scroll(پیدایش

در صورتی که موس دارای دکمه وسط چرخشی باشد در هر پنجره باز اگر دکمه وسط را به  

 بالا و پایین بچرخانیم محتویات پنجره برای نمایش به بالا و پایین حرکت می‌کند.

)Drag &Drop( کشیدن و رها کردن

دکمه چپ موس را بر روی شکل دلخواه کلیک کرده و بدون رها کردن آن شکل مذکور را به محل دلخواه کشیده 
و رها می‌کنیم.
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)Desktop(میز کار ویندوز -

میز کار ویندوز )Desktop( در حقیقت همان ناحیه کار اصلی ویندوز است که می‌توانیم در آن محیط برنامه‌های 
کاربردی خود را انجام نماییم. پرونده‌های دلخواه خود را مشاهده و ویرایش نماییم و فضای کار ویندوز را مطابق 

ذوق و سلیقه خود تنظیم کنیم. می‌توانیم بگوییم که:

تمام صفحه اصلی ویندوز را که به عنوان ناحیه کاری استفاده می‌شود میز کار ویندوز می‌گویند.



14

)Icon(آیکن

تصاویر کوچک گرافیکی موجود در ویندوز را که معرف برنامه، پوش��ه و یا اس��ناد و مدارک باشد برای انتخاب هم 
زمان چند آیکون کافیست کلید Ctrl را گرفته  و بر روی آیکون‌ها کلیک نماییم.

)Folder(پوشه

محلی برای نگهداری فایل‌ها و برنامه‌ها می‌باشد که با نماد تصویری نشان داده می‌شود.                

Taskbarنوارکار

نوار افقی در پایین‌ترین نقطه میز کار است که شامل برنامه‌های در حال کار، منوی شروع و سایر ابزارهای مورد 
نیاز می‌باشد و دسترسی به برنامه‌ها و تنظیمات آن‌ها را آسان می‌نماید.

Tray barسینی ویندوز

قس��مت راس��ت نوار کار شامل اطلاعات و آیکن‌هایی از قبیل ساعت و زبان سیستم می‌باشد که به آن  سینی نوار 
ابزار ویندوز می‌گویند.
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)Menu(منو
لیس��تی از عناوین برنامه‌ها و دس��تورات قابل دسترسی در ویندوز است که گاهی هر برنامه شامل زیر برنامه‌هایی 

نیز می‌باشند.

برای مشاهده منوی شروع بر روی  کلیک کرده تا پنجره آن ظاهر شود.

 - اشاره‌گر موس را بر روی دستورات آن حرکت می‌دهیم تا انتخاب شود.

 - برای اجرای یک دستور با موس بر روی آن کلیک می‌کنیم.

 - برای بستن لیست منوها بر روی ناحیه‌ای خالی از میز کار کلیک می‌کنیم.
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Windowپنجره

هر برنامه کاربردی یا پوشه در قالب یک پنجره نمایان می‌شود کافیست بر روی پوشه یا برنامه کاربردی مورد نظر 
)مثلاmy computer( دابل کلیک کرده تا پنجره آن ظاهر شود.

)Title bar( نوار عنوان

نوار رنگی افقی بالاترین قسمت هر پنجره را که شامل نام برنامه یا پوشه حاوی آن می‌باشد را نوار عنوان گویند.

- ب��ه وس��یله موس ب��ر روی نوار عن��وان دابل کلی��ک می‌نماییم پنج��ره به حداکث��ر اندازه ممک��ن تغییر پیدا 
می‌کند)maximize( اگر دوباره دابل کلیک نماییم پنجره به اندازه قبلی تغییر می‌کند.

- با پایین نگه داش��تن کلید س��مت چپ موس بر روی نوار عنوان و جابجا کردن ماوس پنجره جابجا می‌ش��ود 
)Move(.
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)Menu bar( نوار منو

نوار افقی واقع در زیر نوار عنوان پنجره می‌باشــد که فرامین لازم برای کار با برنامه یا پوشــه در آن قرار دارد.

اگر در پنجره فایلی کلید ALT را به 
همراه حرفی که زیر آن خط کشــیده 
شده است بکار ببریم منوی مربوط باز 

خواهد شد.

ALT+V :  مثال

Toolbars نوار ابزار

نواری از دکمه‌های تصویری که در زیر نوار منو قرار دارد و برای دسترســی آسان به فرامین و امکانات هر پنجره 
بکار می‌رود.

)Address Bar( نوار آدرس

نوار آدرس کادر ســفید رنگی اســت که معمولا زیر نوار ابزار اکثر پنجره‌ها وجود دارد و درســت چپ آن کلمه 
Addres نوشــته شده است این نوار به ما این امکان را می‌دهد که آدرس برنامه‌ها پوشه‌ها و.... در آن تایپ کرده 

و فوری به آن دسترسی پیدا نماییم.
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)Folder( آشنایی با پوشه -

محلی برای نگهداری فایل‌ها و برنامه‌ها می‌باشد که با نماد تصویری نشان داده می‌شود به طور خلاصه در ویندوز 
مهم‌ترین مقررات نام‌گذاری پوشه‌ها به شرح زیر است.

* طول اسامی پوشه‌ها می‌توانند حداکثر 255 کاراکتر باشند.

* از کاراکترهای زیر نمی‌توان در نام‌گذاری فایل‌ها و پوشه‌ها استفاده کرد.

                          *|\/:ʺ><؟

* استفاده از حروف بزرگ و کوچک در نام‌گذاری مجاز است.

* بعضی از نام‌ها در  سیستم عامل رزرو شده و نمی‌توان آن‌ها را برای نام‌گذاری استفاده کرد.

CON-LPT1-LPT2-LPT3-NUL-PRN-COM1-COM2-COM3-COM4

Folder ایجاد پوشه -

برای ایجاد پوشه به ترتیب زیر عمل می‌نماییم:

- بر روی نقطه خالی از میز کار یا هر محل دلخواه دیگر راست کلیک می‌نماییم.

 - از منوی ظاهر شده گزینه New و سپس گزینه Folder را انتخاب می‌نماییم.
- پوشه‌ای جدید با پیش فرض New Folder ساخته می‌شود نام آن را به دلخواه تغییر می‌دهیم.
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- کپی و تغییر نام انتقال و حذف پوشه

* نمایشگر را بر روی پوشه مورد نظر برده و کلیک راست می‌نماییم و دستور Copy را انتخاب می‌نماییم.

* پوشه مورد نظر به حافظه موقت )CLIP BOARD( منتقل می‌شود.

* در محل مورد نظر )محل کپی پوشه(کلیک راست کرده و گزینه Paste را انتخاب می‌کنیم.

* پوشه به محل مورد نظر انتقال می‌شود.

* برای تغییر نام پوشه بر روی آن کلیک راست کرده و گزینه Rename را انتخاب می‌کنیم.

* نام پوشه آبی رنگ شده و می‌توان نام آن را تغییر داد.

* جهت انتقال فایل همانند روش Copy عمل کرده ولی به جای انتخاب Copy دستور CUT را انتخاب می‌نماییم.

* جهت حذف پوش��ه بر روی آن کلیک راس��ت کرده و گزینه Delete را انتخاب می‌کنیم. در این حالت پوشه 
مورد نظر موقتا به صندوقRecycle Bin می‌رود.

* اگر بخواهیم پوشه مورد نظر کاملا حذف شود کافیست در موقع حذف کلید  Shift را پایین نگه داریم.
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 )File( مفهوم و کاربرد پرونده -

تمامی اطلاعات و برنامه‌های موجود در کامپیوتر صرف نظر از نوع یا محتوای آن‌ها در File نگهداری می‌شود. 
مثلا یک فایل می‌تواند شامل یک متن یا یک تصویر باشد.

فایل‌ها همانند پوش��ه‌ها و با همان قواعد دارای نام و پس��وندی دلخواه می‌باش��ند ولی پسوند فایل‌ها با توجه به 
ALi.EXE :محتوای آن‌ها تعیین می‌گردد و با یک نقطه از نام فایل جدا می‌شود. مثلًا

*پسوندهای EXE .bat،comمربوط به فایل‌های اجرایی می‌باشد.

*پسوندهای DOC،TXT مربوط به فایل‌های متنی می‌باشد.

*پسوندهای gif،Jpg،BMP مربوط به فایل‌های تصویری می‌باشد.

*پسوندهای bak،DWG مربوط به فایل‌های نرم افزار AUTOCADمی‌باشد.

پسوندهای RAR.ZIP مربوط به فایل‌های فشرده می‌باشد.

- انتقال کپی تغییر نام و حذف فایل

فایل‌ها را می‌توان همانند پوشه مدیریت کرد بدین صورت که بر روی فایل کلیک راست کرده و از پنجره نمایان 
شده عملیات مورد نظر را انجام داد.
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Send to با دستور File کپی-

برای این منظور کافیست بر روی File راست کلیک کرده و از گزینه Send to انتقال مورد نیاز را انجام دهیم.

- جستجوی فایل‌ها و پوشه‌ها و.....

search گزینه Desktop  واقع در صفحه star برای جس��تجوی یک فایل یا پوش��ه کافیست از قس��مت منوی
را انتخاب نماییم تا پنجره زیر نمایان ش��ود در این قس��مت می‌توان گزینه مورد نظر را انتخاب کرده و عملیات 

جستجو را انجام دهیم.
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Formatاصول فرمت -

هنگام��ی که بخواهیم محتویات درایو، فلاپی، فلاش را از بین ب��رده و مجدداً پیکربندی نماییم عملیات فرمت را 
انج��ام می‌دهیم در این حالت کافیس��ت بر روی حافظه مورد نظر کلیک راس��ت ک��رده و گزینه فرمت را انتخاب 

نماییم.
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ا

1. اجزای اصلی میز کار ویندوز را نام ببرید؟

2. چند مورد از برنامه‌هایی را که از طریق دکمه start می‌توان به آن‌ها دسترسی پیدا کرد را نام ببرید.

3. هدف از انجام عمل دابل کلیک روی آیکن برنامه‌ها چیست؟

4. برای جابجا کردن پنجره چه عملی را انجام می دهیم؟

5. اجزای اصلی یک پنجره را توضیح دهید؟

6. یک پوشه با نام AUTOCAD در درایو D ایجاد کرد و یک فایل داخل آن کپی نمایید؟

7. پسوند های اجرایی در یک فایل را نام ببرید؟

8. یک فلاپی درایو یا یک Flash memory را با سیستم NTFS فرمت نمایید؟

9. برای انتخاب چند آیکن پراکنده در میز کار و یا یک پنجره از ترکیب کدام دکمه‌ها استفاده می‌شود.

CTRL+Click)الف

CTRL+Rright Click)ب

SHIFT+Click)ج

SHIFT+RrightClick)د

10. کدام نوار امکان دسترسی سریع به برنامه و پوشه‌ها را فراهم می‌سازد؟

Toolbar)الف

Address bar)ب

Search bar)ج

Menu bar)د

 ارزشیابی پایانی 

     - سئوالات تشریحی

     - سئوالات چند گزینه‌ای



24

11. در صورت کوچک بودن اندازه یک پنجره با چه ابزاری می‌توان کلیه محتویات درون آن پنجره 
را باز دید کرد؟

Drag)الف

Scroll bar)ب

Address)ج

Mycomputer)د

12.کدام یک از اسامی زیر برای نام پوشه غیر مجاز است؟

Directory)الف

Photo*Baby)ب

ASP)ج

List.name)د

13.محل قرار گرفتن یک فایل یا پوشه کپی شده در ...... می‌باشد.

الف(حافظه اصلی 

ب( هارد دیسکت

Clip board)ج

Rom)د

14.برای حذف دایمی فایل‌ها و پوشه‌ها از کدام گزینه استفاده می‌کنیم؟

Delete)الف

Recyclebin ب(کشیدن و انداختن در

Shift+Del)ج

CTRL+Del)د
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 15.کدام یک از اسامی زیر را می‌توان برای نام‌گذاری نام فایل استفاده کرد؟

COM1)الف

COM)ب

PORT)ج

NUL)د



    واحد کار
دوم



اهداف رفتاری:
پس از آموزش این واحد کار از فراگیر انتظار می‌رود:

- نرم افزار اتوکد را از طریق صفحه Desktop و منوی Start اجرا نماید.
- اجزای محیط کاری نرم افزار اتوکد را بیان کند.

- اصول کار و روش‌های ورود فرمان‌های اتوکد را شرح دهد.
- تنظیمات محدوده ترسیم آن را انجام دهد.

- از موس و صفحه کلید جهت انتخاب منوها استفاده کند.

- روش‌های اجرای دستورات ذخیره‌سازی و فراخوانی فایل در اتوکد را انجام دهد.

هدف کلی : توانایی اجرای نرم افزار اتوکد و اجرای دستورات مربوط به 

ذخیره‌سازی و فراخوانی فایل‌ها در اتوکد.

پیش آزمون:)10 دقیقه(

1. به چند طریق می‌توان یک نرم افزار را اجرا کرد؟
2.کلیدهای موس چه وظایفی را بر عهده دارند؟

3. منظور از نوار عنوان در پنجره نرم‌افزارها چیست؟
4. محدوده‌های ترسیم استاندارد را نام برده و ابعاد آن را طبق اصول نقشه‌کشی بنویسید؟

5. نحوه بستن یک نرم‌افزار به چه صورت است؟
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AUTOCAD راه‌اندازی و اجرای نرم افزار -

* انتخاب آیکن نرم افزار که بر روی صفحه Desktop قرار دارد                       

و دابل کلیک بر روی آن

* بر روی آیکن فوق کلیک راست کرده و گزینه Open را انتخاب می‌نماییم

 AUTOCAD ش��ده و طبق ش��کل زیر بر روی  فایل اجرایی All program وارد قس��مت Start از منوی *
کلیک می‌کنیم.
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AUTOCAD آشنایی با محیط نرم افزار -

پس از ورود به محیط اتوکد پنجره زیر را در اختیار داریم.

DRAWING AREA صفحه ترسیمی-

صفحه سیاه رنگ موجود در پنجره اتوکد صفحه ترسیمی می‌باشد که در این صفحه نماد     

مع��رف  محور مختصات y،x و صفحه کاری دو بعدی می‌باش��د و  مکان نم��ا )Cursor(به منظور ابزار طراحی و 
نقشه کشی وجود دارد.

)دقت نمایید پنجره نمایش داده شده مربوط به فضای کاری AUTOCAD CLASSICمی‌باشد.(
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MENU BAR نوار منو

نوار منو یا نوار کرکره‌ای در قسمت بالای پنجره AUTOCAD می‌باشد که شامل فرمان‌های اتوکد می‌باشند که 
هر کدام شامل زیر مجموعه‌هایی از دستورات مدیریتی، ترسیمی، ویرایشی و .... می‌باشند 

به منظور استفاده از نوار منو روی مورد نظر رفته و کلیک می‌نماییم.

Tool bar نوارابزار

دس��تورات و فرمان‌ه��ای نرم افزار CAD به ص��ورت تصویری در نوارهایی قرار دارند که هر نش��انه دارای تصویر 
خاصی است که معمولا بیانگر نوع عملکرد و دستور می‌باشد برای اجرای هر دستور کافیست بر روی تصویر دستور 

مورد نظر کلیک نماییم.
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- نوار ابزارهای مورد نیاز 

برخی از نوار ابزارهای لازم برای ترسیم به صورت زیر می‌باشند:
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- فعال کردن یک نوار ابزار 

* برای فعال کردن یک نوار ابزار مورد نیاز کافیست بر روی یک آیکن کلیک راست کرده و از پنجره ظاهر شده 
نوار ابزار مورد نیاز را انتخاب نماییم.

ACAD اگ��ر در فضای خال��ی نوار منو )منوی کرکره‌ای(مقابل یک نوار ابزار کلیک راس��ت نماییم از ش��اخه *
می‌توانیم نوار ابزار مورد نیاز را فعال کنیم.

COMMAND خط فرمان -

یکی از قس��مت‌های مهم در نرم افزار قس��مت خط فرمان اس��ت در این نواحی می‌توان دس��تورات و یا مخفف 
دستورات را به طور مستقیم تایپ نمود.

                              Command:Line         اجرای دستورخط

Command:L              مخفف دستور خط
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Status barنوار وضعیت -

مطابق ش��کل بالا نوار وضعیت در زیر خط فرمان قرار دارد که ش��امل نمایش مختصات مکان نما )Cuorsor( و 
کلیدهایی برای فعال و غیرفعال کردن برخی فرمان‌ها و تنظیمات آن‌ها است.

-برای غیر فعال شدن محل نمایش مختصات مکان‌نما کافیست بر روی آن کلیک نماییم 

-کلیدهای سریع قسمت Status bar بشرح زیر است.
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- روش‌های ورود فرمان‌های اتوکد

* استفاده از نوار منو )menu bar(:کافیست دستور مورد نیاز را در منوی مربوطه پیدا کرده و اجرا نماییم برای 
این منظور موس را بر روی منوی مربوطه برده و دستور را انتخاب می‌کنیم.

* اس��تفاده از نوار ابزار )Tool bar(:در این روش کافیس��ت تصویر دستور مورد نظر را شناخته و با کلیک بر روی 
آن دستور را اجرا نماییم.

* اس��تفاده از خط فرمان)Command bar(: دس��تور مورد نیاز را به طور کامل یا به طور خلاصه در این قسمت 
type می‌نماییم و کلید ENTER را می‌زنیم.
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اگر در صفحه ترسیم راست کلیک نماییم منویی باز می‌شود که به آن منوی میان بر )Short cut menu(گویند 
و از طریق آن می‌توان آخرین فرمان اجرا شده با برخی فرمان‌های پر کار دیگر را انتخاب و اجرا کرد.

- بع��د از تای��پ فرمان در خط فرمان برای اجرای آن کافیس��ت کلید  EnterیاSpace bar یا راس��ت کلیک 
نماییم.

- اگر در قسمت خط فرمانEnter نماییم آخرین فرمان اجرا شده قبلی مجدد اجرا می‌شود.

- ب��ا کلیدهای بالا و پایین )واقع در صفحه کلید( می‌توان دس��توراتی را که قب�ال اجرا نمودیم پیدا کرده و در 
صورت لزوم آن را استفاده و اجرا کنیم.

- از مخفف دس��تورات نیز می‌توان جهت اجرای یک دس��تور اس��تفاده کرد مثلا بجای Line حرف L را تایپ 
نماییم. این خلاصه دستورات را در فایلی بنام ACAD.PGP می‌توان تعریف کرد.

محدوده ترسیم و تنظیمات آن :

بطور معمول در ترسیمات نقشه ابعاد کاغذ جهت ترسیم را مطابق با ابعاد نقشه تهیه کرده و در نظر می‌گیرند 
مثلا کاغذ های A3،A4و.....

نکات:



36

در نرم افزار AUTOCAD در ابتدا بایس��تی محدوده ترس��یم )صفحه س��یاهرنگ ( را وارد کرده یعنی طول و 
عرض صفحه‌ای را که می‌خواهیم در آن ترسیم را انجام دهیم تعیین نماییم برای این منظور دستورLimits را 

در خط فرمان تایپ می‌نماییم و به ترتیب شکل عمل می‌نماییم.

Command:Limits    اجرای دستور

 Specify Lower Left Corner>0مختصات گوشه سمت چپ و پایین صفحه >0و

Specify  Upper Rright Corner>12مختصات گوشه سمت راست و بالای صفحه>9و

- به عنوان مثال اگر بخواهیم محدوده ترسیم‌ها  A3 افقی باشد کافیست:

در گوشه سمت چپ و پایین )Lower Left Corner( مختصات 0و0 وارد کرده و در گوشه راست و بالای 
صفحه)Upper Rright Corner( مختصات 297 و 420 وارد نماییم.	
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                     توجه

بعد از تنظیم محدوده ترس��یم به کمک دس��تور Limits  کافیس��ت در قسمت خط فرمان دستورات زیر را انجام 
نماییم.

COMMAND:Z   A  

روش انتخاب منوها و دستورات :

ALT اجرای دستور از طریق نوار منو: این روش در واحد کار توضیح داده شده است بدین ترتیب که کلید-
           و  را گرفته و کلمه‌ای که زیر آن خط کش��یده ش��ده را می‌زنیم بعد از باز ش��دن منوی مربوطه با کلید های

صفحه کلید دستور مورد نظر را انتخاب می‌نماییم.

- بوس��یله م��وس روی منوی مورد نظ��ر رفته و با کلیک کردن بر روی آن منو را باز کرده و دس��تور را انتخاب و 
کلیک می‌نماییم.

کلیدهای موس :

کلید سمت چپ= انتخاب موضوع یا کلیک

کلید سمت راست= اینتر )همچنین کلید Spacebar نیز همین عمل را انجام می‌دهد(

نگه داشتن کلید وسط و حرکت دادن موس =Panجابجایی ترسیم

چرخاندن کلید وسط=Zoom  بزرگنمایی ترسیم
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- فراخوانی و ذخیره سازی 

Save.Save AS ذخیره‌سازی *

برای ذخیره س��ازی یک ترس��یم کافیس��ت از منوی File و ی��ا از منوی تصویری گزین��هSave را انتخاب نماییم 
هنگامیکه برای اولین بار این دستور اجرا می‌شود پنجره زیر نمایان می‌شود 

                     توجه:
- اگر بخواهیم ترس��یم را با نامی متفاوت ذخیره نماییم از منوی File گزینه Save as را انتخاب می‌نماییم در 

این حالت پنجره فوق نمایان می‌شود می‌توانیم در قسمت نام فایل نام جدید را وارد نماییم.

-از کلید های ترکیبی Ctrl+S نیز می‌توان برای ذخیره سازی استفاده کرد.

Drawing .Dwg می‌باشد مثلا Dwg پسوند فایل‌های ترسیمی -

- فایل‌های ترسیمی CADبا پسوندهای زیر نیز ذخیره می‌شوند.

*Dxfفایل‌هایی که قابل باز شدن در سایر نرم افزارهای گرافیکی می‌باشند.

Dwtفایل‌هایی که به عنوان پیش فرض TemPlateجهت شروع ترسیم استفاده می‌شود.
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Quite پنجره ترسیم را ببندیمclose  را انجام دهید با زدن Save اگر در اتمام ترسیم بدون اینکه عمل -
را در خط فرمان تایپ نماییم پنجره زیر نمایان می‌شود.که می‌توانیم با انتخاب:

-گزینه Yesعمل ذخیره‌سازی یا Save را انجام دهیم.

-گزینه NO از ذخیره‌سازی و یا اعمال تغییرات منصرف شویم.

-گزینه Cancel از پنجره باز شده را ببندیم.
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نما و......و نماد......است. 1. در صفحه ترسیمی اتوکد 

2. اگر در صفحه ترسیمی کلیک راست نماییم منویی باز می‌شود که به آن .....گویند.

3. مراحل اجرای نرم افزار اتوکد را بنویسید.

4. روش تنظیم محدوده ترسیم را شرح دهید؟

5. روش فعال کردن یک نوار ابزار را توضیح دهید؟

6. یک دستور را از چه روش‌هایی می‌توان اجرا کرد؟

7.کلیدهای عملکرد سریع دستورات Startus bar را بنویسید؟

 ارزشیابی پایانی )در زمان 15 دقیقه(

نظری

1. نرم افزار اتوکد را اجرا نمایید.

2. محدوده ترسیم مطابق با یک کاغذ A2 را برای نرم افزار تعریف کنید.

3. نواره��ای اب��زار Text .Zoom،Layers،Dimension، Modify.Drawرا فعال کرده و اطراف 
صفحه ترسیمی قرار دهید

4. یک فایل با نام ACAD.DWT باز نمایید

5. فایل باز شده را با نام CNC ذخیره نمایید.

6. از نرم افزار خارج شوید.

 ارزشیابی پایانی )در زمان 45 دقیقه(

عملی



    واحد کار
سوم
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اهداف رفتاری:

پس از آموزش این واحد کار از فراگیر انتظار می‌رود:

1. سیستم مختصات را تعریف نماید.

2. دستگاه مختصات کارتزین و قطبی تعریف کند.

3. مختصات نقاط یک نقشه ترسیمی را به صورت مطلق نسبی و قطبی استخراج نماید.

4. روش‌های وارد کردن مختصات بصوت مطلق نسبی و قطبی را در نرم افزار اتوکد شرح دهد. 

هدف کلی : شناخت روش‌های مختصاتی

پیش آزمون:)20 دقیقه(

1.منظور از مختصات z،y،x جهت مشخص کردن یک نقطه چیست؟

2.ی��ک مربع ب��ا ابعاد 80×100 در صفحه ترس��یم نماید بطوریکه مح��ور مختصات در مرکز آن 
باشد.

3.یک نقطه با مشخصات )80و50( را در صفحه مشخص نماید.
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سیستم مختصات

در ترسیمات هندسی و ریاضیات به منظور ترسیم اشکال مختلف از قبیل نقطه، خط، منحنی، صفحه و حجم به 
سیستم مختصات نیاز داریم.

فاصله هر طولی و عرضی نقطه روی ترسیم نسبت به یک مرجع سنجیده می‌شود که به آن مرکز محور مختصات 
می‌گویند.

- سیستم مختصات کارتزین

برای تعریف مختصات در یک صفحه به دو مولفه x،y و در فضا به سه مولفه x،y،z نیاز داریم.

مولفه x بیانگر فاصله طولی )افقی(نسبت به نقطه مرجع )مبنا( می‌باشد.

مولفه x بیانگر فاصله عرضی )عمودی( نسبت به نقطه مرجع )مبنا( می‌باشد.

- مثلا مختصات یک نقطه در صفحه که فاصله آن از محور x ،30 میلی متر و از محور y ،40 میلی‌متر اس��ت به 
صورت )40وp)30 نمایش داده می‌شود.

40

30

y

p

x

در صورتیکه فاصله همین نقطه از محور z ،50 میلی باش��د مختصات نقطه به صورت )P)30.40.50نمایش داده 
می‌شود z=50 ، y=40،x=30 ، بدین معنا است که نقطه از صفحه ترسیمی 50 میلی‌متر بالاتر است.

     

 

    

z

40

30

y p

x

50
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                       نکته

بر اساس استاندارد در ماشین‌های افزار محور Z در امتداد محور اصلی ماشین )اسپیندل( و محورهای x،y بر 
روی میز ماشین فرض گردیده‌اند.

                        

40

100

y

Ax

x

x=0

y=0

)0،0(

مثال: مخصات نقطه)Aَ)َ100.50 را ترسیم نمایید.              

1.ف��رض می‌کنی��م می‌خواهی��م از مرج��ع محور 
مختص��ات به صورت افقی و روی محورx  به اندازه 

100 میلی‌متر جلو برویم.تا به نقطه AX برسیم.                                         

                            

50

A

x
x=0

y=0

100
)0،0(

                   
Y 2. از ای��ن نقط��ه بطور عمودی و م��وازی محور
 A ب��ه اندازه 50 میل��ی متر بالا رفته ت��ا به نقطه

برسیم.            

 

                                    

- مختصات مطلق و نسبی

در سیستم مختصات کارتزین یک نقطه به دو صورت تعریف می‌شود. 

1. مختصات مطلق:

در این سیستم موقعیت تمام نقاط یک ترسیم نسبت به مرجع و مبداء مختصات سنجیده می‌شود.

در این حالت مختصات نقاط P1تاP4 به صورت زیر است:

P1)10.20(
y

                                                                   P2)100.20(

P3)100.50(

P4)10.50(

x
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- مختصات نسبی

در این سیس��تم موقعیت هر نقطه نس��بت به نقطه قبلی خودش س��نجیده می‌ش��ود.یعنی برای بدس��ت آوردن 
مختصات هر نقطه محور مختصات را در نقطه قبلی قرار داده و نقطه جدید را نسبت به آن می‌سنجیم.

مختصات نقطه P1  نسبت به مبدا مختصات )10.20(P1 )یعنی از مبدا مختصات می‌خواهیم به نقطه P1 حرکت کنیم.

مختصات P2نسبت به 90.0(P1(P2)یعنی از نقطه P1می‌خواهیم به نقطه P2حرکت کنیم.

   

y

x

y

x
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مختصات P3  نسبت بهP3)0.50( :P2 یعنی از نقطه P2 می‌خواهیم به نقطه P3حرکت کنیم.

مختصات P4نسبت به P4)-90.0( :P3یعنی از نقطه P3 به نقطه P4حرکت کنیم.
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AUTOCAD مختصات مطلق و نسبی در نرم افزار -

برای وارد کردن مختصات به صورت مطلق در نرم افزار CAD کافیس��ت ابتدا یک دس��تور ترسیمی اجرا نماییم 
در قسمت خط فرمان )COMMAND( اگر جملات:

 Specify First Point نقطه اول را مشخص نمایید -

Specify LAST Point نقطه آخر را مشخص نمایید -

Specify NEXT Point نقطه بعدی را مشخص نمایید -

 Specify CENTER Point نقطه مرکز را مشخص  نمایید -

ظاهر گردید بدین معنی است که بایستی مختصات یک نقطه را وارد نماییم

در صورتی‌که مختصات نقطه را به صورت دو عدد که بین آن‌ها ویرگول قرار د ارد وارد نماییم مختصات به صورت 
مطلق در نظر گرفته می‌شود

و اگر قبل از وارد کردن مختصات نماد نسبی  )Shlft +2( @ را بنویسیم مختصات نقطه به نقطه قبلی درج شده 
و در نظر گرفته می‌شود
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اگر در نرم افزار Auto Cad در قسمت Statusbar بر روی DYN مخفف Dynamic input کلیک راست 
کرده و گزینه Settings را بزنیم پنجره مربوط به تنظیمات این قسمت نمایان می‌شود.

گزینه Enabel Dimension input where possible را فعال نماییم برای درج مختصات به صورت نسبی 
دیگر نیازی به وارد کردن نماد @ نمی‌باشد.
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- مختصات قطبی 

در سیســتم مختصات قطبی برای نشــان دادن موقعیت یک نقطــه واقع بر یک صفحه از دو پارامتر اســتفاده 
می‌شود.

- طول و یا فاصله نقطه تا نقطه قبلی

-  زاویه خط )و اصل نقطه تا نقطه قبلی( با زوایه صفر درجه

- قطبی مطلق

α فاصله نقطه p تا مبدا مختصات 

x زاویه بین این خط و محور  Ɵ

که از نقطه قبلی می‌گذرد.   

               
- قطبی نسبی

α فاصله نقطه P1  تاP2  به صورت نسبی

 زاویه خط P1P2   با خطی که به صورت افقی 

از P1  می‌گذرد.

مثال: مختصات نقاط داده شده را به صورت قطبی نسبی بنویسید.
p1=22/3>63ο  نسبت به مبداء مختصات

p1 نسبت به  P2=90>0ο

p2 نسبت به  P3=30>90ο

p3 نسبت به   P4=90>180ο

y

p

x

Ɵ

y p

x

Ɵ

α

P1
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Auto Cad نحوه اعمال مختصات نقطه به صورت قطبی نسبی در -

برای این منظور کافیست در قسمت خط فرمان و زمانی که مختصات یک نقطه را از ما می‌خواهد به صورت شکل 
مختصات قطبی نسبی  را وارد نماییم.

اگر مطابق ش��کل از قسمت Starusbar گزینه Setting را زده و ...  Enabel Dimension input را فعال 
نماییم هنگام ترسیم کافیست با نمایشگر زاویه دلخواه را مشخص کرده و طول مورد نظر را وارد نماییم.
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AUTO CADتعیین مختصات یک نقطه در

برای مشخص کردن مختصات یک نقطه به ترتیب زیر عمل می‌نماییم

1. بر روی ترس��یم کلیک کرده تا انتخاب ش��ود و مربع‌های آبی رنگ بر روی آن ظاهر ش��ود. این عمل باش��د 
.command هنگامی انجام می‌دهیم که در قسمت خط فرمان فقط کلمه نمایشگرCursur را بر روی مربع آبی 

رنگ قرار داده تا به رنگ سبز در آید..

3. در این حالت مختصات نقطه در نوار مختصات مشخص می‌شود.
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1. سیستم مختصات را تعریف کرده و مختصات کارتزین را شرح دهید.

2. تفاوت تعیین موقعیت یک نقطه به صورت مطلق یا نسبی چیست؟

3. در سیستم قطبی زاویه یک نقطه نسبت به چه مکانی تعیین می‌شود؟

عملی 45دقیقه

1. تنظیمات DYN را انجام دهید

2. مختصات نقاط شکل‌های زیر را به صورت مطلق و نسبی بنویسید.

نظری 15 دقیقه

ارزشیابی پایانی 



    واحد کار

چهارم
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توانایی‌ها:
1. توانایی اجرای دستورات ترسیمی و ویرایشی

Line -Circle-Erase-Trim-Ortho-Rectangle-Undo-Redo-Units

2. توانایی اجرای دستورات ترسیمی و ویرایشی
Arc-Osnap-Copy-Move-Fillet-Chamfer-List

3. توانایی اجرای دستورات ترسیمی و ویرایشی 
Rotate-Scale-Array-Mirror-Offset-Hatch

هدف کلی : اجرای فرمان‌های ترسیمی ویرایشی و 
AUTOCAD کمک ترسیمی‌توانایی‌ها نرم افزار

اهداف رفتاری توانایی 1:

پس از آموزش این واحد کار از فراگیر انتظار می‌رود:

1. ترسیم خط و دایره را به روش‌های مختلف در اتوکدتوانایی ترسیم کند.

2. روش‌های پاک کردن موضوعات با استفاده از دستوراتErase,trim را انجام دهد.        

3. خطوط افقی و عمودی را ترسیم کند.

5. مستطیل را به روش‌های مختلف ترسیم کند.

6. یک شکل هندسی شامل خط و دایره را ترسیم کند.

هدف کلی :توانایی اجرای دستورات ترسیمی و ویرایشی
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1. به چه طریق می‌توان مختصات یک نقطه را به صورت مطلق نسبی و قطبی در نرم افزار وارد کرد؟

2. علامت مختصات قطبی یک نقطه چیست؟

3. برای )cancle(کردن یک دستور از چه کلیدی در keyboard می‌توان استفاده کرد؟

4. کدام کلید برای پاک کردن در صفحه keyboard استفاده می‌شود؟

5. برای ترسیم یک پاره‌خط چه مشخصاتی لازم است؟

6. اگر نقاط C،B،A مطابق شکل قرار داشته باشند مطلوبست:

الف: مختصات نقطه B نسبت به نقطه A به صورت مطلق 

ب: مختصات نقطه B نسبت به نقطه C به صورت نسبی

ج: مختصات نقطه C نسبت به نقطه A به صورت قطبی 

 

پیش آزمون

C

A

B

40

100
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دستور کار 1
قبل از آموزش لازم است معانی و کاربرد لغات و اصطلاحات زیر فرا گرفته شود،

LINE     خط                                                                            

CIRCLE   دایره                                                                      

RECTANGLE مستطیل                                                     

ERASE  پاک کردن                                                               

TRIM  برش موضعی                                                           

ORTHO افقی و عمودی کردن مکان نما                                  

UNDO خنثی کردن دستور                                                    

REDO                                                                 undo معکوس

UNITS   واحدها                                                                  

COMMAND خط فرمان                                                  

SPECIFY                                                    مشخص کردن

FIRST POINT                                                 اولین نقطه 

NEXT POINT نقطه بعدی                                               

SECOND POINT                                            نقطه دوم

CORNER   گوشه                                                               

OTHER دیگری                                                                

CENTER   مرکز                                                                 

RADIUS شعاع                                                                  

DIAMETER قطر                                                            

CLOSE          بستن                                                                    

DRAW   ترسیمی                                                                   

MODIFY اصلاح کردن                                                         
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line  فرمان
از این دستور برای ترسیم یک پاره خط به صورت‌های مختلف استفاده می‌شود.

را از سه طریق می‌توان اجرا کرد

Menubar: draw>line

Toolbar: draw>line

Command : line  یا L   

همانطور که می‌دانید برای ترسیم یک پاره خط مشخص کردن نقطه ابتدا و انتهای آن لازم است بنابراین می‌توان 
برای ترسیم یک پاره‌خط نقاط ابتدا و انتها را به دو صورت زیر وارد کرد.

1.تایپ مختصات ابتدا و انتها در خط فرمان 
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2. انتخاب دو نقطه با استفاده از نمایشگر موس

در صورتی که بخواهیم مختصات دو نقطه را به وسیله نمایشگر موس به صورت مطلق مشخص نماییم لازم است 
تنظیمات مطابق شکل را در قسمت DYN انجام دهیم

                           نکته:
برای فعال و غیر فعال کردن DYN از کلید F12 صفحه کلید می‌توان استفاده کرد

در این حالت کافیست نمایشگر را در صفحه ترسیمی حرکت داده تا مختصات مورد نظر ظاهر شود.

و ب��ا کلیک کردن این نقطه به عنوان اولین نقطه انتخاب می‌ش��ود نقاط بع��دی را نیز می‌توانیم به همین ترتیب 
انتخاب نموده و ترسیم را انجام دهیم.
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                            نکات:
1. فرمان line برای ادامه محدودیتی ندارد و می‌توان به تعداد دلخواه پاره‌خط ترسیم کرد.

2. با وارد کردن گزینهUndo آخرین نقطه انتخاب شده لغو می‌شود.

ORTHO دستور -

به وسیله این دستور می‌توان حرکت نمایشگر را در حالت‌های افقی و عمودی محدود کرد.

ORTHO  نحوه فعال کردن

1. ازقسمت Status bar بر رویORTHO کلیک نماییم 

2. کلید F8 )بر روی keyboard( را بزنیم

                        نکته:
کلید ORTHO فقط هنگامی عمل می‌کند که یک دستور ترسیمی مثلا line اجرا شده باشد.
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UNITS فرمان

از این دستور برای تنظیم واحدهای طولی و زوایا استفاده می‌شود 

برای اجرای فرمان بر دو روش عمل می نماییم تا جدول تنظیمات UNITS ظاهر شود  

MENU BAR : FORMAT>UNITS

COMMAND : UNITS

تنظیمات UNITS در تمامی قسمت‌های زیر تاثیر می‌گذارد.

 1. نمایش مختصات مکان‌نما

DYN 2.نمایش موقعیت در هنگام ترسیم و فعال بودن

.LISTو  DIST 3. در هنگام استفاده از دستورات
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دستور کار 1

1. ترسیم یک مربع با ابعاد 50 ×100 به 5  روش‌های زیر :

استفاده از مختصات گوشه‌های شکل به صورت مطلق: دستور line را اجرا کرد و در قسمت خط فرمان 
)command( به ترتیب مختصات نقاط P4، P3، P2 ،P1 را وارد می‌نماییم تا شکل ترسیم شود.

توجه:
در حالت ترسیم کلید DYN غیر فعال باشد.

 نکته:
بعد از وارد کردن نقطه P3 کافیست حرف C در خط فرمان را تایپ کرده تا شکل کامل گردد.

  نکته:

بعد از وارد کردن هر مختصات کلید ENTER را می‌زنیم.

نکته:
استفاده ازu )مخفف undo( به جای مختصات در جلوی فرمان  

Specify next point or [undo]

باعث لغو مختصات داده شده  قبلی می‌شود و می‌توان مختصات جدیدی را وارد کرد
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2. استفاده از مختصات گوشه‌های شکل به صورت نسبی:  
نقطه P1 نسبت به مبدا مختصات  

  P1 نسبت به نقطه P2 نقطه
 P2 نسبت به نقطه P3 نقطه
P3 نسبت به نقطه P4 نقطه

و در نهایت از گزینه Close برای رسم خط
 از P4 به P1 استفاده می‌کنیم.

بعد از اجرای دستور LINE مختصات را به صورت نسبی)با قرار دادن علامت @ قبل از مختصات( وارد می نماییم.               

   نکته:

مختصات نقطه اول را به صورت مطلق وارد می‌نماییم. 

3. استفاده از مختصات شکل به صورت قطبی نسبی :    

نقطه P1 به صورت مطلق 

نقطه P2 نسبت به P1  به طول 90 و زاویه صفر

نقطه P3 نسبت به P2  به طول 30 و زاویه 90

نقطه P4 نسبت به  P3 به طول 90 و زاویه 180  

 P1 به P4 برای رسم از  close و در نهایت از گزینه

استفاده می‌کنیم.

                      

                           نکته:
اگر طول و زاویه نقطه P1 نسبت به نقطه قبلی را نداشتیم مختصات آن را به صورت مطلق وارد می‌نماییم.
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بعد از اجرای دستور LINE مختصات را به صورت قطبی نسبی وارد می‌نماییم. 

زاویه خط نسبت به نقطه قبل < طول خط با علامت مثبت@

4. با استفاده از طول پاره‌خط و فرمان ORTHO کلید F8 را می‌زنیم تا فرمان ortho  فعال شود و حرکت مکان 
نما محدود حرکت افقی و عمودی گردد.

- دستور LINE را اجرا کرده و مختصات اولین نقطه را به صورت مطلق وارد می نماییم.

- مکان نما در حالت افقی به سمت راست قرار داده و مقدار 90طول پاره خط P1 P2  را وارد می‌کنیم.

- مکان نما در حالت عمودی و رو به بالا قرار داده و مقدار 30 طول پاره خط P2 P3  را وارد می‌کنیم.

- مکان نما در حالت افقی و سمت چپ قرار داده و مقدار 90طول پاره خط P3 P4  را وارد می‌کنیم.

- حرف c مخفف close را زده تا شکل کامل شود.

DYN 5. با استفاده از مختصات شکل و فرمان

تنظیم��ات DYN  را همانطور که قبلا توضیح داده ش��ده انجام می دهی��م و با کلید F12 آن را فعال می‌کنیم و 
دستور LINE را اجرا می‌کنیم.

توجه: فرمان  ORTHO  را غیر فعال کنید. 

 Precision نمایش اعداد به صورت بدون اعشار باشد یعنی قسمت UNITS توجه:در تنظیمات
بر روی صفر باشد.



64

برای ترسیم شکل کافیست بوسیله موس به مختصات نقاط P1  رفته و کلیک نماییم به همین ترتیب سایر نقاط 
را پیدا کرده و کلیک می‌نماییم.                                                                  

                          نکته:
برای کامل شدن شکل بعد از انتخاب نقطه P4 حرف C  را تایپ کرده و ENTER می‌نماییم.

ERASE فرمان

از این فرمان جهت پاک کردن یک ترسیم استفاده می‌شود 

اجرای فرمان
Menubar:Modify> Erase
Toolbar : Modify> Erase

Command: Erase یا E

بعد از اجرای دستور موضوعات مورد نظر را انتخاب کرده و کلید ENTER را می‌زنیم.
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  نکته:

ب��رای پ��اک کردن موضوعات ترس��یمی می‌توان ابتد آن‌ها را انتخاب کرد تا Highlight ش��وند و س��پس کلید 
DELETE روی KEY BOARD را می‌زنیم.

CIRCLE فرمان

اجرای فرمان

Menubar : Draw> Circle>...

Toolbar : Draw> Circle

Command :  Circle یا c

بعد از اجرای فرمان از نوار ابزار DRAW یا تایپ آن در خط فرمان لازم است ابتدا مختصات مرکز و سپس شعاع 
دایره را وارد نماییم.

 نکته :
اگر بخواهیم دایره را با اندازه قطر رسم نماییم کافیست در قسمت

Specify radius of circle or [Diameter]: D 

حرف D را تایپ کرده تا جمله زیر ظاهر شود و در این قسمت می‌توانیم مقدار قطر را وارد نماییم.
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Specify Diameter of circle

روش‌های دیگر ترسیم دایره-
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CENTER-RADIUS 1.رسم دایره به کمک مرکز و شعاع

- انتخاب مرکز دایره 

- وارد کردن مقدار شعاع  

 

CENTER-DIAMETER2.رسم دایره به کمک مرکز و قطر

- انتخاب مرکز دایره

- وارد کردن قطر دایره

2POINT 3.رسم دایره به کمک دو نقطه

- انتخاب دو نقطه

3POINT 4.رسم دایره به کمک سه نقطه

- انتخاب سه نقطه
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TAN.TAN.RADIUS.5. رسم دایره مماس بر دو شکل و شعاع دایره

- انتخاب دو شکل

- وارد کردن شعاع دایره

TAN.TAN.TAN 6. رسم دایره مماس بر سه شکل

- انتخاب سه شکل

یاد آوری 

جهت وارد کردن یک نقطه مثلا مرکز دایره به 3 روش می‌توان عمل کرد:

1. بوسیله مکان‌نما بر روی صفحه ترسیمی کلیک نماییم.

 2. مختصات نقاط را به روش مطلق و یا نسبی در خط فرمان تایپ نماییم.
3. از DYN کمک گرفته و بوسیله موس مختصات نقطه را بطور دقیق تنظیم کرده و کلیک نماییم.

RECTANGLE  دستورمستطیل
 از این دستور جهت ترسیم یک چهارضلعی استفاده می‌شود.

Menubar: Draw> Rectangle

Toolbar : Draw> Rectangle

Command :  Rectangle یا Rec

برای ترسیم چهار ضلعی مختصات دو نقطه لازم است.
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بعداز اجرای دستور مختصات دو نقطه خواسته شده را وارد می‌نماییم برای این منظور می‌توانیم در خط زمان 
مختصات را تایپ نماییم و یا با فعال کردن DYN و تنظیم units بوسیله موس چهار ضلعی را ترسیم نماییم.

TRIM دستور پاک کردن موضعی

هنگامی که دو یا چند ترس��یم با هم برخورد داش��ته باشند و بخواهیم قس��مت یا بخش‌هایی از ترسیم را حذف 
نماییم از این دستور استفاده می نماییم

Menubar: Modify> Trim

Toolbar : Modify> Trim

Command:  Trim یا Tr
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 ABبعد از اجرای دستور ابتدا بایستی لبه یا مرزهای برش را انتخاب کرد: مثلا برای پاک کردن پاره خط

خطوط 1.2 بعنوان مرزهای برش انتخاب کرده و پس از زدن ENTER پاره خط  AB را انتخاب می نماییم.

نکته:

اگر در قس��مت انتخاب مرزهای برش >SELECT OBJECT OR <SELECT ALL بدون هیچ انتخابی کلید 
ENTER را بزنیم تمامی ترس��یم بعنوان لبه‌های برش انتخاب می‌شوند در این حالت هر قسمتی را که بخواهیم 

می‌توانیم حذف نماییم.

UNDO فرمان

به کمک این فرمان می‌توانیم دس��تورات اجرا ش��ده قبلی را لغو نماییم و یا به بیان دیگر با اجرای هر بار فرمان 
UNDOیک مرحله به عقب باز می‌گردیم.

Menubar: Edit> Undo
Toolbar : Standard> Undo
Command:  Undo یا U یا Ctrl+z

REDO فرمان

در صورتیکه از  فرمان  UNDO استفاده کرده باشیم به کمک دستور REDO می‌توانیم دستور مراحل لغو شده 
را باز گردانیم و با اجرای هر بار آن یک مرحله به جلو برویم

Menubar: Edit> Redo
Toolbar : Standard> Redo
Command:  Redo یا Ctrl+y

انتخاب مرزهای برش ..........................

Command:  Trim

SELECT OBJECTS OR<SELECT ALL>2خطوط 1و

SELECT  OBJECT TO TRIM:AB انتخاب پاره خط 
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دستور کار 1

شکل روبرو را ترسیم نماییم
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دستور کار 2
شکل زیر را به کمک دستورات فرا گرفته ترسیم نمایید



73

1. فرم��ان line را از چن��د طریق می‌توان اجراکرد و روش‌های ترس��یم یک پاره‌خط را ش��رح 
دهید؟

2. تنظیمات unit در چه مواقعی کاربرد دارد؟

3. روش‌های پاک کردن یک ترسیم را توضیح دهید؟

4. معنای جمله Specify first point چیست؟

5. اصطلاح خط به زبان انگلیسی ..................................... می‌شود.

5- اصطلاح دایره به زبان انگلیسی....................................می‌شود.

7. برای فعال و غیر فعال کردن DYN از چه کلیدی استفاده می‌شود؟

F10 )د                    F3 )ج                       F8)ب                     F12)الف

8. برای فعال کردن دستور ORTHO از چه کلیدی استفاده می‌شود؟

F10 )د                    F3 )ج                       F8)ب                     F12)الف

9. برای ترسیم دایره به روش دو مماس و شعاع از چه دستوری استفاده می‌شود؟

Tan-Tan-Radiv )ب                           Tan-Tan-Tan )الف

circle  .  Diameter )د                                      point 3 )ج 

10. مخفف دستور Trim چیست؟

الف(T                     ب(Tr                       ج( Tri                    د( هیچکدام

نظری 15 دقیقه

ارزشیابی پایانی 
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شکل‌های زیر را در کاغذ A4 ترسیم کرده و هر کدام را با نام متفاوتی ذخیره نمایید.

عملی 15 دقیقه

ارزشیابی پایانی 
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توانایی 2 :توانایی اجرای دستورات ترسیمی و ویرایشی

Arc-Osnap-Copy-Move-Fillet-Chamfer-List-Dist-Grip

اهداف رفتاری:

پس از آموزش این توانایی از فراگیر انتظار می‌رود:

1. معنای کاربردی دستورات و فرامین این قسمت را بداند.

2. توانایی ترسیم کمان برش‌های مختلف را فرا گیرد.

3. توانایی استفاده از گیره‌های شی :Objectsnap در ترسیم را فرا گیرد

4. مشخصات یک ترسیم را با استفاده از دستور List استخراج نماید.

5. توانایی اندازه‌گیری فاصله بین دو نقطه را با استفاده از دستور Dist فرا گیرد.

6. از خطوط کمکی Tracking در ترسیم یک شکل استفاده نماید.

7. توانایی جابجایی یک ترسیم را با استفاده از دستورات Grip،Move،Copy فرا گیرد.
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پیش آزمون

    1- برای پاک کردن پاره خط AB و سپس BC از چه دستوراتی بایستی استفاده کرد؟

                                  2 - اگر شکلی را توسط دستور Erase پاک کرده باشیم  به کمک چه دستوری می‌توان آن را باز گرداند.

               3- نقاط Grip را چگونه می‌توان فعال کرد؟

               4- جهت جابجا کردن یک ترسیم بکمک نقاط Grip چه عملی را بایستی انجام داد.

               5- به کمک چه دستوری می‌توان شکل روبرو را ترسیم کرد.

         

               6- روش‌های اجرای یک دستور را توضیح دهید.

C

B

A

R50  

50  

50  
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Start             شروع

Point            نقطه

Center           مرکز

End   انتها

Lenght   طول وتر

Continue   ممتد

Arc   کمان

Object snap   گیره‌های شی

Copy   کپی

Move   جابجایی

Fillet   گرد کردن گوشه

Chamifer   پخ زدن گوشه ها

List   مشخصات ترسیم

Dist   فاصله

Grip   نقاط کمکی

Tracking   خطوط کمکی

Base point   نقطه مبنا

End point   نقطه ابتدا و انتهای خط پایان یا کمان

Midpoint   نقطه میانی

Tangent   مماس

Intersection   محل برخورد

Perpendicular   عمود

Parallel   موازی

Angle   زاویه

Radius   شعاع

Circumference   محیط

Area   مساحت
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Arc   فرمان -

به کمک این دستور می‌توان یک کمان به روش‌های مختلف ترسیم کرد.

اگر دس��تور کمان را در خط فرمان تایپ نماییم در این صورت با انتخاب س��ه نقطه می‌توان یک کمان رسم کرد 
هم چنین اجرای دستور کمان از قسمت نوار ابزار نیز به همین صورت اجرا می‌شود.

فرمان کمان را می‌توان به روش‌های زیر اجرا کرد.
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)Object snap) osnap ابزارهای -

به کمک این ابزار می‌توان نقاط مشخصی از شکل را انتخاب کرد و در ترسیمات جدید مورد استفاده قرار داد به 
عنوان مثال می‌خواهیم یک دایره در وس��ط یک خط ایجاد نماییم و یا از مرکز یک دایره خطی به مرکز دایره‌ای 

دیگر ترسیم نماییم. ابتدا لازم است نقاط یک ترسیم شناخته شود.

Osnap فعال کردن -

به چند طریق زیر می‌توان گیره‌های شی را فعال کرد

1-در قس��مت Status bar بر روی Osnap کلیک راس��ت کرده و گزینه Setting را انتخاب می‌کنیم تا پنجره 
مربوطه باز شود سپس در قسمت Object snap موارد مورد نیاز را تیک می‌زنیم تا به طور دائمی فعال شود.
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2- هنگام ترسیم می‌توان به طور موقت از این گیره‌ها استفاده کرد برای این منظور نوار ابزار Object snap را 
فعال می‌کنیم .)بر روی یکی از آیکون ها کلیک راست کرده و گزینه Object snap را تیک می‌زنیم(

3-روش دیگر اس��تفاده موقت از گیره‌های ش��ی استفاده از CTRL و کلید س��مت راست موس می‌باشد در این 
حال��ت پنجره‌ای ظاهر می‌ش��ود که اب��زار های Snap در آن قرار دارد در این حال��ت می‌توان گزینه مورد نظر را 

انتخاب کرد.

نکته: 

با انتخاب روش اول گزینه‌هایی که در پنجره Osnap  تیک خورده اند به طور دائم فعال می باشند .

                        نکته:با انتخاب روش دوم و سوم فقط یک بار از Osnap مورد نظر می‌توان استفاده کرد.
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Move ، Copy فرمان‌های -

با استفاده از این فرامین می‌توان یک ترسیم را کپی نمود یا جابجا کرد.

اجرای فرمان

Menubar :Modify> Copy or Move

Command:Copy or Move

بعد از اجرای فرمان، موضوع یا موضوعات )Select Objects( را به وس��یله موس انتخاب کرده و کلید Enter را 
می‌زنیم. س��پس یک نقطه به عنوان مبنای حرکت را به وس��یله موس و به کمک Osnap انتخاب می‌نماییم و در 

آخر نقطه مقصد را مشخص می‌کنیم.

- می‌خواهیم دایره ترس��یم  ش��ده در گوش��ه مس��تطیل را به گوش��ه دیگر انتقال داده و یا در گوشه دیگر ایجاد 
نماییم.
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Chamfer ، Fillet فرمان

برای گرد کرد ن گوشه‌ها از دستور Fillet ، و برای پخ زدن گوشه‌ها از دستور Chamfer استفاده می‌شود.

Menubar:Modify>Fillet Chamfer

Toolbar:Modify<

بعد از اجرای دس��تور Fillet مقدار ش��عاع را وارد کرده و سپس دو موضوعی که می‌خواهیم بین آن‌ها Fillet زده 
شود انتخاب می‌‌نماییم.

Command:Fillet

Select First Object or (Undo/  polyline/Radius/Trim) :R

Specify Fillet R adus

نکته: اگر مقدار R در دستور Fillet منو داده شود دو شکل به صورت تیز به هم می‌رسند.

برای پخ زدن گوشه‌ها به دو روش زیر می‌توان عمل کرد.
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1- تعیین فاصله عمودی و افقی پخ

2- تعیین طول خط )در راستای انتخاب اول( و زاویه پخ

List فرمان

به کمک این دستور می‌توان مشخصات یک ترسیم را از قبیل طول پاره‌خط، زاویه خط، مختصات نقاط شروع و 
پایان خط، مرکز دایره، شعاع دایره، مختصات مرکز دایره، مساحت و محیط دایره را به دست آورد.

برای این منظور کافیس��ت ترس��یم مورد نظر را انتخاب کرده و دس��تور List را در قس��مت Command تایپ 
نماییم.
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Dist فرمان

به کمک این دس��تور می‌توان فاصله دو نقطه را به دس��ت آورد برای این منظور دس��تور را اجرا کرده و به کمک 
موس و ابزار Osnap دو نقطه را انتخاب می نماییم فاصله طولی ،افقی و عمودی دو نقطه نمایش داده می‌شود.

Grip فرمان

Grip مربع‌های آبی رنگی می باش��ند که هنگام انتخاب یک ترس��یم به وسیله موس ظاهر می شوند.اگر موس را 

ب��ر روی مربع‌ه��ای کناری قرار داده و کلیک نماییم مربع آبی رنگ، قرمز می‌ش��ود و در این حالت قادر به تغییر 
اندازه ترسیم می‌باشیم.

به کمک مربع‌های میانی می‌توان ترسیم را جابجا کرد و عملیات Move را انجام داد.

 

                         نکته:  اگر در حالتی که مربع قرمز رنگ می‌باشد کلیک راست نماییم پنجره‌ای ظاهر می‌شود 
که به کمک دستورات آن می‌توان عملیاتی نظیر Rotate،Move،Copy را بر روی ترسیم انجام داد.
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دستور کار 1

مطلوب است ترسیم شکل روبرو
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تئوری

آزمون پایانی

1- در ترسیم کمان منظور از Lenght چه اندازه‌ای می‌باشد؟

     الف( قطر کمان          ب( قطر کمان           ج( شعاع کمان        د(وترکمان

2- برای مماس کردن یک پاره‌خط به دو دایره از کدام Osnap استفاده می‌شود.

Line:Tan،Tan)الف

Line:End،End)ب

Line:Quadrant،Tangent)ج

Line:Tangent،Endpoint)د

3- برای رساندن دو پاره‌خط به یکدیگر از چه دستوری می‌توان استفاده کرد؟

Trim)الف

Grip)ب

Fillet)ج

Chamfer)د

4- جهت اندازه‌گیری فاصله دو گوشه یک مستطیل از دستور .............. استفاده می‌شود.

5- جهت انتقال سریع وسط یک خط به مرکز یک دایره از نقاط ........... استفاده می‌شود.

Quadrant -6 چهار نقطه اصلی ................. نام دارد.
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                   مطلوبست ترسیم  مرحله‌ای شکل‌های زیر 
عملی

آزمون پایانی
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توانایی 3 :توانایی اجرای دستورات ترسیمی و ویرایشی

Rotate-Scale-Array-Mirror-Offset-Hatcth-Ucs 

                    اهداف رفتاری

                  پس از آموزش این توانایی از فراگیر انتظار می‌رود:
1- معنای کاربردی دستورات و فرامین این قسمت را بداند.

2- توانایی دوران دادن یک شغل و تغییر مقیاس آن را دارا باشد.
3- توانایی تکثیر یک شغل  به صورت سطری ستونی و دایروی داشته باشد.

4- توانایی ایجاد تصاویر آینه‌ای و با فاصله مشخص را داشته باشد.

5- انواع خطوط هاشور را بشناسد و توانایی هاشور زدن و ویرایش آن را بداند.

1- به کمک نقاط کمکی Grip چه دستوراتی را می‌توان انجام داد.

2- در کدام قسمت می‌توانیم Osnap های مشخصی را  به طور ثابت فعال نماییم.

3- برای فعال و غیر فعال کردن Osnap از کدام کلید تابعی استفاده می‌نماییم.

4- می‌خواهیم محیط و مساحت یک مستطیل به ابعاد 50×100را به دست آوردیم.

برای این منظور از چه دستوری استفاده نماییم.

5- مختصات ابتدا و انتهای یک خط عبارت اس��ت از )B)60/90(، A)20/30 به کمک کدام دس��تور 
می‌توانیم طو ل و زاویه خط را به دست آوردیم.

6- اگر بخواهیم چهار گوشه یک مستطیل با اجرای یک دستور Fillet گرد شوند به چه طریقی باید 
عمل نماییم.

پیش آزمون
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واژه نامه

Rotate   دوران
Scale   مقیاس
Base point   نقطه مبنا
Rotation angle   زاویه دوران
Scale Factor ضریب بزرگنمایی
Rectangular Array   تکثیر سطری و ستونی
Polar Array   تکثیر دایروی
Row سطر
Column   ستون
Origin   مبدا
Mirror تصویر آینه ای -متقارن
Hatch   هاشور

Rotate فرمان

برای دوران یک ترسیم حول یک مرکز از این دستور استفاده می‌شود.

Menubar:Modify>Rotate

Command:Rotate   or Ro
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نکته : مرکز دوران را با توجه به شکل ترسیم بایستی انتخاب کرد.

                          

                                نکته: بعد از انجام Rotate شکل اولیه حذف می‌گردد چنان چه اگر به شکل اولیه نیاز داشتیم.

می‌توانیم قبل از وارد کردن مقدار زاویه حرف C مخفف Copy را وارد کرده و بعد از زاویه را وارد نماییم.

Specify Rotation angle or [copy / Reference] :c

Scale فرمان

به کمک این دس��تور می‌توانیم مقیاس یک ش��کل یا ترس��یم را تغییر دهیم یعنی آن را بزرگ تر یا کوچک تر 
نماییم.

Menubar:Modify>Scale

Command:Scale or Sc
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ARRAY فرمان

برای تکثیر یک شکل به صورت سطری و ستونی و یا دایروی از این دستور استفاده می‌شود.

Menubar:Modify>Array

Command:Array  or  AR

بعد از اجرای دستور پنجره زیر نمایان می‌شود که ابتدا بایستی در قسمت Select Objects موضوع مورد تکثیر 
را انتخاب نماییم و با زدن کلید Enter به پنجره Array بازگشته و سایر تنظیمات را انجام دهیم.

- تکثیر سطری و ستونی
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- تکثیر دایروی

 Select تیک می‌زنیم و در قسمت Polar Array در این حالت بعد از اجرای دستور در پنجره نمایان شده قسمت
Object موضوع یا موضوعاتی که می‌خواهیم به صورت دایروی تکثیر ش��وند انتخاب کرده و Enter  را می‌زنیم 

سپس تعداد موضوعات و زاویه تکثیر را تعیین می نماییم.
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MIRROR دستور

به کمک این دستور می‌توان یک ترسیم آینه ای ایجاد کرد یعنی نسبت به یک محور تصویری متقارن ایجاد کرد.

Menubar:Modify>Mirror

Command:Mirror or Mi

 Osnap نکته:برای انتخاب محور متقارن می‌توانیم دو نقطه از یک ش��کل را با اس��تفاده از
انتخاب نماییم و همیشه لازم  به رسم یک محور تقارن نمی‌باشد.
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Offset دستور

از این دستور برای ایجاد تصاویر موازی و با فاصله مشخص استفاده می‌شود.

Menubar:Modify > Offset

Command:Offset  or  O

نکته: در صورتی که نخواهیم عملیات Offset تکرار شود کلید Enter را می‌زنیم.
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برای هاشور زدن شکل‌های بسته از این دستور استفاده می‌شود.

Menubar:draw>Hatch

Command:Hatch   or   H

نکته: برای ویرایش کافیست بر روی هاشور دوبار کلیک نماییم.
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UCS دستور

برای جابجایی محور مختصات بر روی شکل از این دستور استفاده می‌شود.

محور مختصات در هر جای ش��کل قرار بگیرد آن نقطه )صفر و صفر(در نظر گرفته می‌ش��ود و مابقی نقاط نقشه 
نسبت به محور مختصات سنجیده می‌شود برای این منظور کافیست دستور Origin از نوار ابزار Vcs را انتخاب 

کرده و نقطه مورد نظر بر روی ترسیم را به کمک Osnap انتخاب نماییم.

فرض کنید می‌خواهیم محور مختصات در مرکز دایره قرار گیرد.

نکته: برای به دست آوردن مختصات چهار نقطه )Quadrant( دایره کافیست بر روی دایره 
کلی��ک نماییم تا نقاط Grip بر روی آن ظاهر ش��ود ح��ال با قرار دادن موس بر روی هر مربع مختصات ان نقطه 

نسبت به مرکز تغییر پیدا می‌کند.
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عملی

آزمون پایانی

شکل‌های زیر را رسم نماییم و سپس با قرار دادن مختصات بر روی یک نقطه دلخواه سایر 
مختصات نقاط را استخراج کرده و برنامه آن را بنویسید.
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    واحد کار

پنجم
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هدف کلی :آشنایی با سیستم های تولیدی یکپارچه کامپیوتری

اهداف رفتاری:
پس از آموزش این توانایی از فراگیر انتظار می‌رود که بتواند:

1. انواع روش تولید در صنعت را شرح دهد.

2- سیستم‌های کنترل عددی  را توضیح دهد.

3- کاربرد کنترل عددی در ماشین‌های افزار را شرح دهد. 

4- اصول ایمنی با دستگاه را نام ببرد.
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NC آشنایی با سیستم‌ های کنترل عددی
تا پیش از دهه 50 میلادی دونوع روش تولید در صنعت موجود بود

– تولید تکی یا دسته‌ای:
   در ای��ن روش تولید بوس��یله ماش��ین‌های ابزار،  به ص��ورت مکانیکی و 
بوس��یله اپراتور انجام می‌ش��ود و دقت ابعاد نهایی قطعه کار  کاملا  وابسته به 

دقت ومهارت اپراتور می‌باشد.

  به همین دلیل معایب زیر بوجود می آید:

 - سرعت پایین تولید

- یکسان نبودن ابعاد قطعات مشابه 

–تولید انبوه:
در این روش قطعات با حجم تولید کم یا متوسط وبا عملیات دستی تولید می‌شوند

    در این روش قطعات با کیفیت مناسب‌تر و با تعداد زیاد تولید 

   می‌شود اما برای ایجاد تغییر در نوع تولید لازم است تا تغییرات 

  زیادی در ماشین‌ها، ابزارها وقید و بندها صورت گیرد. 

در این روش قطعات با حجم تولید بالا به صورت خودکار و با طراحی ثابت تولید می‌شوند

البت��ه کیفیت قطعات تولیدی در هر دو روش قابل قبول و پاس��خگوی نیازهای آن زمان بود. در آن ش��رایط 
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لازم بود تولید یک محصول به مرور زمان با  اصلاح کیفیت، بهبود عملکرد افزایش قابلیت‌ها وحتی قابلیت شکل 
ظاهری آن همراه شود.و در این صورت تولید خودکار قدیمی جوابگوی این نیاز نبود. 

از طرف��ی دیگر پس از جنگ جهانی دوم، در س��اخت محصولاتی  
مثل هواپیما و اتومبیل‌های پیش��رفته از قطعاتی اس��تفاده شد که 
دارای ش��کل‌های پیچیده بوده و دقت تولید بالایی را می‌طلبیدند و 
تولید این قطعات بوسیله ماشین‌های ابزار معمولی امکان پذیر نبود.

در نتیجه برای پاسخگویی به نیازهای پیش آمده، اولین ماشین 
کنترل عددی )NC( در دانش��گاه ماساچوست)MIT( ساخته شد 
این ماش��ین‌های کنترل عددی قادر به کنترل تنها یک محور بودند 
اما به مرور زمان قابلیت کنترل سه محو.ر حرکتی را نیز پیدا کردند.

NC تعریف فنآوری- 

  به بیان ساده NC یا کنترل عددی عبارت است از بکارگیری کدهای ویژه‌ای شامل اعداد،حروف وعلائم 
برای کنترل عملکرد ماشین و ساخت قطعات و ایجاد اتوماسیون.

برای مثال یک بلوک)ش��امل اعداد، حروف وعلائم( می‌تواند به یک ماش��ین NC دس��تور دهد که اسپیندل 
دستگاه با سرعت دورانی وپیشروی مشخص به نقطه ای حرکت نماید.

با اجرای خط فرمان زیر اسپیندل دستگاه با سرعت 100میلیمتر بر دقیقه به مختصات مشخص شده Z،Y،X می‌رود                                                                                         

N10   G01  X80  Y50   Z10  F10:

در ماشین‌هایNC اولیه از نوار کاغذی سوراخ‌دار

 برای کنترل حرکت محورها استفاده می شد. 

بدین ترتیب که اطلاعات حرکتی و ماشین‌کاری در 
قسمت‌های مشخصی برروی نوار کاغذی سوراخ می‌شود 
و بعد از اتمام کار نوار متش��کل از برنامه ماشین‌کاری به 

دستگاه نوار خوان انتقال داده می‌ شود.
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  NCدر دستگاه نوار خوان اطلاعات بر روی کاغذ ،رمز گشایی شده وبه صورت پالس‌های الکتریکی به دستگاه
منتقل می‌شود . دستگاهNC عملیات ماشین‌کاری را انجام می‌داد                                                                                                             

  

 NC هنگام پانچ هر برنامه، کاغذ پانچ به تدریج از ماشین خارج می‌شود و به واحد کنترل ماشین

   MCU  (Machine  Control  Unit) وارد می‌ش��ود. این ماش��ین دارای حافظه نمی‌باشد و فقط قادر است 
یک بلوک از دستور را خوانده و برای اجرا به دستگاه NC منتقل کند با استفاده از این رشته‌های نوار پانچ 

قادر خواهیم بود هر تعداد از یک نوع قطعه را تولید نماییم.

اکثر ماش��ین‌های NC برای عملیات ماش��ین‌کاری احتیاج به کددهی توس��ط س��وراخ‌هایی بر روی نوارهای 
کاغذی داشت. 

که با گسترش صنعت این عملیات مشکلاتی را از قبیل: صرف زمان زیاد، امکان ایجاد خطا، عدم امکان ساخت 
قطعات پیچیده  را به همراه داشت.

این روش ادامه داشت تا اینکه در دهه 60 ایده کددهی وکنترل عددی توسط کامپیوتر مطرح گردید. در این 
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سیستم دیگر نیازی به استفاده از نوار سوراخ‌دار و دیسکت جهت ذخیره و انتقال اطلاعات نبود و برنامه مستقیما 
از کامپیوتر توسط کابل به کنترل ماشین منتقل می‌شد.

به این روش انتقال اطلاعات کنترل عددی مستقیم گفته می‌شود

(Direct Numerical Computer) DNC

در این روش اطلاعات از طریق یک کابل به نام RS232 به دستگاه منتقل می‌شود

در ده��ه 70 ب��ا کاهش ابعاد ریز پردازنده ها یک کامپیوتر به کنترل NC اختصاص داده ش��د وکنترل عددی 
کامپیوتری یعنیCNC بوجود آمد.

CNC  (Computer  Numerical  Control)
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کامپیوتر در س��ازمان واحد کنترل ماش��ین 
جاگرفت��ه واجازه می‌ده��د برنامه‌ه��ا از طریق 
نرم‌افزارش��ان به وجود  آید و در حافظه ذخیره 

شوند. 

پس از یک بار نوش��تن برنامه، هرچندبار که 
لازم باش��د با رجوع به حافظه اجرای آن امکان 

پذیر است.

ب��ه کارگیری ماش��ین‌های CNC علاوه بر 
افزای��ش دو روش قدی��م تولی��د )تولید تکی و 
انبوه( امکان تولید قطعات به صورت نیمه انبوه 
و پیچی��ده را فراهم می‌آورد که از نظر اقتصادی 

توجیه پذیر است..

CNC اجزای اصلی ماشین‌های
بطور کلی ماشین ابزارCNC از سه بخش عمده نرم افزار ،واحدکنترل و سخت افزار تشکیل شده‌اند

1- نرم افزار

شامل برنامه ماشین و مجموعه‌ای از اعداد،حروف

 و نشانه‌هایی اس��ت که به ماشین می‌گوید چه عملی باید انجام 
دهد

این برنامه شامل اطلاعاتی نظیر روش ومسیر ماشین‌کاری

قطعه،مقادیر سرعت دوران ، پیشروی ،دستور روشن وخاموش 
کردن موتورها و .... می‌باشد.

نوار سوارخدار
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اطلاعات از روش‌های زیر به دستگاه منتقل می‌شود:

- نوار سوراخدار

 -نوار مغناطیسی

 -دیسک مغناطیسی

)MDI(از طریق صفحه کلید دستگاه -

     MDI=Manual Data Input

در این روش اطلاعات را مس��تقیما با اس��تفاده از صفحه کلید نصب 
برروی دستگاه منتقل می‌کنیم

 DNCاستفاده از کامپیوتر-   

Unit Control Machine )UCM( 2- واحدکنترل

این قس��مت در حقیقت اصلی‌ترین قسمت ماش��ین‌های کنترل عددی 
می‌باشد .صدور و قطع کلیه فرمان‌های ماشین کنترل عددی در این قسمت 

صورت می‌گیرد.

 در حقیق��ت این قس��مت برنامه نوش��ته ش��ده به صورت علائ��م و...را 
رمزگشایی کرده و به برنامه حرکتی تبدیل می‌نماید و عملیات ماشین‌کاری 

را کنترل می‌نماید.

نوار مغناطیسی

برنامه وارده به صورت کدهای رمز بندی شده می‌باشد که پس  
از ورود به دس��تگاه در واحد کنترل تفسیر می‌شود و برای اجرا به 

دستگاه منتقل می‌گردد.

دیسک مغناطیسی

صفحه کلید دستگاه

کنترل فانوک
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کنترلر‌ه��ای ماش��ین‌های CNC ب��ا توجه به اس��تانداردهای 
مختلف��ی که وجود دارند س��اخته می‌ش��وندکه معروف‌ترین آن‌ها 
کنترل‌های زیمنس، فانوک،هایدن‌های،ميتسوبيشی، فاگور، فيدیا،  

انگل هارد، هاست، تسلاو... می‌باشد..

اجزای واحد کنترل عبارت است از :

RAMحافظه،CPU،نوارخوان،میکروپروسسور 	-

حافظهPLC ،ROM، تقویت کننده،تابلوی کنترل و...

3- سخت افزارماشین‌های کنترل عددی شامل دو قسمت زیر می‌باشد:

- بخش مکانیکی: 

   شامل بدنه، میز،کله‌گی، سیستم انتقال حرکت شامل جعبه دنده،  پیچ‌های،  راهنما ، سیستم یاتاقان بندی 
و.. می‌باشد.

در ماشين‌های سنتی معمولاً از پيچ‌های رزوه ذوزنقه‌ای برای

 تامين حرکت پيشروی کشویی و ميز استفاده می‌شود ولی در

ماشین‌های CNC از پيچ‌های ساچمه‌ای استفاده می‌گردد.

 قلب یک سيستم پيشروی در ماشين‌های CNC پیچ و مهره

 ساچمه‌ای می‌باشد. هنگامی که حرکت دورانی از موتور به

 پيچ منتقل می‌شود، ميز ماشين از طریق مهره، حرکت خطی

 پيدا می‌کند. 

کنترل زیمنس
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- بخش الکترونیکی:

  این بخش شامل سیستم محرکه)موتورهای الکتریکی( 
وسیستم اندازه‌گیری تقسیم بندی می‌شوند.

- سیستم محرکه: در ماشينCNC از سه نوع سيستم 
محرک��ه الکتریک��ی، هيدروليک��ی و پنوماتيکی اس��تفاده 

می‌شودکه نوع پنوماتیکی آن استفاده نمی‌شود.

 Stpping Motorsموتورهای پله‌ای -

این موتورها دارای س��اختمان ساده ، کم حجم و قيمت مناسب 
می‌باشد. از آن‌ها در CNC های ساده با دقت محدود وگشتاورهای 

نسبتاً کم و قدرت کمتر از hp1 استفاده مي‌شود
موتور پله‌ای
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 ( DC )موتورهای جریان مستقيم -

موتورهای DC بيشــترین اســتفاده را در ماشــين‌های  CNCدارند این 
موتورها دارای قدرت بالا، ســرعت یکنواخت و عکس العمل سریع نسبت به 

تغييرات سرعت مي‌باشند

 ( AC )موتورهای جریان متناوب-  

در موتورهای AC کنترل دور با تغيير فرکانس می‌باشد 

     این امر هزینه بسيار بالایی را نسبت به موتورهای DC در بر دارد.   
عدم نياز به یک سو کننده تعمير و نگهداری ارزان‌تر به دليل نداشتن 

کلکتور و جاروبک از مزایای این موتورها می‌باشد

	

- محركه‌های هيدروليکی:

کنترل قدرت‌های زیاد با نيروی کم سادگی کنترل  سرعت 
و نيرو به طور پله‌ای و عکس العمل ســریع در برابر تغيير جهت 
از ویژگی‌های محرك‌های هيدروليکی می باشند. از معایب آن‌ها 
نشــتی و قيمت گرانشــان می‌توان نام برد و نيز این سيستم‌ها 
دارای ســرعت عمل کمتری نســبت به محرکه‌های الکتریکی 

می‌باشند.

- سیستم اندازه‌گیری

 برای کنترل عملیات ماشــین‌کاری پارامترهای موقعیت، سرعت 
و نیرو توسط سنسورهای موقعیت دیجیتالی اندازه‌گیری می‌شوند. 

این سنسورها در سه نوع انکودر زاویه‌‌ای، انکودر چرخشی و خطی 
ساخته‌ می شوند و در یکی از محل‌های زیر نصب می‌گردند.

DC موتور جریان مستقیم

موتور جریان 

محرکه هیدرولیکی

Heidenhain انکودر خطی مدل
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انتهای محور موتور 	-1

انتهای محور پیج ساچمه‌ای 	-2

میز ماشین 	-3

CNC انواع ماشین افزار
این ماشین‌ها بسیار متنوع بوده و جهت کارهای مختلفی ساخته ‌می شوند که به شرح زیر می‌باشد.

: CNC 1- دستگاه‌های فرز

این دســتگاه‌ها در مدل‌های دروازه‌ای، سنتروبورینگ ساخته ‌می‌شــوند. محورهای این دستگاه‌ها با توجه به 
کاربرد از 2 تا 6 محور خطی و دورانی ساخته‌ می‌شوند.

	

Heidenhain انکودر چرخشی مدل

فرز CNC با 3 محور کنترلفرز مدل دروازه‌ای با 2 محور کنترل

فرز مدل دروازه‌ای با 4 محور کنترل
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CNC 2- ماشین‌های تراش

بوسیله این دستگاه‌ها می‌توان انواع قطعات مدور تولید کرد.

این دستگاه‌ها دارای دو محور حرکتی xوz می‌باشند که ابزار با حرکت در این 2 محور قطعه مورد نظر را

تولید می‌نماید.

CNC نمونه‌ای از قطعات ساخته شده بوسیله دستگاه تراش CNC محورهای حرکتی دستگاه تراش

دستگاه تراش CNC با کنترل زیمنس
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:CNC 3-ماشین‌های اسپارک 

  این ماشین‌ها در دو نوع غوطه وری و سیمی )وایر کات( 
ساخته می‌شوند. به کمک این ماشین‌ها می‌توان قطعات 

پیچیده را تولید کرد.

در دستگاه‌های وایرکات ابتدا شکل قطعه در نرم افزار

طراحی می‌شود و سپس به دستگاه منتقل می‌شود.

دستگاه عمل ساخت را به وسیله یک سیم مسی مصرفی

و عمل تخلیه الکتریکی انجام می‌دهد.

در دستگاه‌های اســپارک برای ساخت یک قطعه ابتدا 
بایستی شکل معکوس آن را برروی یک قطعه مسی ساخته 

و به  وسیله عمل تخلیه الکتریکی قطعه نهایی ایجاد شود.

مدل مسی دستگاه اسپارک

CNCدستگاه وایرکات

HS`HV;CNCدستگاه
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CNC 4- ماشین‌های سنگ زنی

این ماشین‌ها در سه نوع ساخته می‌شوند

1- ماشین‌های سنگ‌زنی گردسا

2- ماشین‌های سنگ‌زنی کف‌سا

3- ماشین‌های سنگ‌زنی ابزار تیزکنی

CNC 5- ماشین‌های خم کنی

این ماشین‌ها اکثراً دارای 3 محور کنترل می‌باشند

و از آن‌ها در صنایع  مختلف استفاده می‌شود.

ماشین سنگ زنی گردسا

ماشین سنگ زنی ابزار تیزکنی ماشین سنگ زنی کف سا
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CNC 6- پرس های

از ماشین‌های پرس CNC نیز در صنایع نظامی برای

ساخت بال‌ها،در صنایع خوروسازی،وبرای ساخت

انواع صندلی و...بکار می‌رود.

CNC دستگاه خم کن
CNC نمونه‌ای از قطعات خم شده توسط دستگاه

CNC قطعه تولید شده بوسیله دستگاه پرس

CNC دستگاه پرس
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CNC 7- ماشین‌های پانچ

این ماشین‌ها دارای کنترل نقطه‌ای می‌باشند و می‌توان 
بایک سنبه، شکل‌های مختلفی را برش داده و ایجاد کرد.

با توجه به اینکه از یک س��نبه کوچک برای برش یک 
س��طح بزرگ استفاده می‌ش��ود نیروی برش به مقدار قابل 

توجهی کاهش می‌یابد

در این روش ابتدا ش��کل مورد نظر در یک محیط نرم 
افزاری 2 بعدی ترس��یم می‌شود وبعد از نوشتن برنامه آن 
به دس��تگاه منتقل می گردد سپس با توجه به ابعاد قطعه 
،س��نبه مورد نظر انتخاب شده و سنبه با برش‌های کوچک 

قطعه مورد نظر را از ورق جدا می نماید.

ماشین‌های دریل CNC دارای کنترل نقطه‌ای

می‌باشند. 

CNC نمونه های سنبه‌های دستگاه پانچ

CNC دستگاه پانچ

CNC قطعات تولید شه بوسیله دستگاه پانچ
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 Plasma8-  ماشین های برش لیزر

به کمک این دستگاه‌ها می‌توان شکل‌های مختلف

را با استفاده از اشعه لیزر با دقت بالا تولید کرد.

 Waterjet9- ماشین‌های برش با آب واتر جت

در این ماشین‌ها آب بافشار زیاد از یک نازل به سطح 
قطعه کار خورده و عملیات برش انجام می‌شود

از ای��ن فرآین��د عمدتا ب��رای برش کاری م��واد نرم 
غیرفلزی مانند مواد مصنوعی،چرم،چوب،کاغذ واس��فنج 

استفاده می‌شود.

CMM 10- ماشین‌های اندازه‌گیری 3 بعدی

               CMM=Coordinate Measurment Machine

با استفاده از این ماشین‌ها می‌توان یک قطعه صنعتی 
را به طور دقیق اندازه‌گیری کرد.

CNC اندازه‌گیری ابعاد بدنه یک ماشین بکمک
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اســاس کار بدین صورت است که یک حساسه از 
جنس یاقوت با نقاطی از قطعه تماس ایجاد می‌کند. 

و مختصات آن را به دست می‌آورد.

از ایــن دســتگاه‌ها در مهندســی معکوس نیز اســتفاده 
می‌کنند بدین ترتیب که با استفاده از نقاط اندازه‌گیری شده 
و انتقــال آن به نرم‌ افزارهای طراحی شــکل قطعه مورد نظر 

ایجاد می‌شود. 

با توجه به شــکل برای طراحی و ترسیم قطعه روبرو ابتدا 
بکمک دســتگاه اندازه‌گیر 3 بعدی مختصات نقاطی از سطح 
استخراج می شود و در نرم افزار مربوطه مثلًا )Catia( بکمک 

این نقاط سطوح ترسیم شده و شکل ایجاد می‌شود.

CNC محورهای ماشین‌های
- سیستم مختصات

   برای تعریف موقعیت یک نقطه خط، منحنی، صفحه  
و حجم به سیســتم مختصات نیازمندیم. در این  سیستم 
سه محور مختصاتی تعریف شده‌ است که به یکدیگر عمود 

بوده و با حروف Z،Y،X تعریف می‌شوند.  

 در ماشین‌های CNC نیز باید تمامی نقاط ماشین‌کاری 
برای دســتگاه قابل شناســائی باشــد تا ابــزار بتواند در 
محدوده ماشین‌کاری دستگاه با توجه به مختصات تعریف 
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شده)Z،Y،X( حرکت نماید.

- محورهای اصلی 

 CNC بط��ور کل��ی منظور از مح��ور در ماش��ین‌های
راس��تای حرکت��ی میز یا اب��زار در مس��یرهای محورهای 

مختصات می‌باشد.

 ماش��ین‌های ت��راش CNC دارای دو مح��ور کنترلی 
می‌باش��ند زیرا اب��زار فق��ط در دو جهت طول��ی وعرضی 
می‌توان��د حرکت کند در ماش��ین‌های تراش CNC محور 
Z ب��ر محوراصلی )اس��پیندل( و یا مح��ور دورانی منطبق 

می‌باشد

- نحوه شناسائی محورهای اصلی

 برای تعین جهت محورهای یک دس��تگاه فرزCNC از قانون دست راست 
به صورت زیر اس��تفاده می‌نمائیم. ابتدا روبروی دس��تگاه ایستاده و سه انگشت 
میانی، اشاره و شصت را عمود بر هم قرار می‌دهیم در حالتی که انگشت میانی 
در راس��تای محور اسپیندل ماشین باش��د در این حالت انگشت شصت جهت 
مثبت محور X و انگش��ت اش��اره جهت مثبت محورY وانگش��ت میانی جهت 

مثبت محور Z را مشخص می‌نماید

- محورهای چرخشی

  علاوه بر سه محور Z،Y،X سه محور چرخشی حول محورهای 
Z،Y،X وجود دارد که بنام‌های C،B،Aمی شناسیم.
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 اســاس اختصاص این محورها بدین علت اســت که 
ابزار بتواند در تمامی جهات حرکت کرده و پیچیده‌ترین 

شکل‌ها را ماشین‌کاری کند

 نکته: هنگام کار با دستگاه فرز CNC بایستی به این نکته توجه کرد که حرکت محورها 
در جهت‌های X و Z, Y توسط میز و اسپیندل انجام می‌شود.
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CNC نقاط مرجع در ماشین‌های
در ماشین‌هایCNC به منظور حرکت دقیق ابزار ، ماشین‌کاری دقیق یک قطعه، تنظیم سیستم اندازه‌ گیری 

و ساده‌تر شدن برنامه نقاطی را به عنوان نقاط مبداء یا نقاط صفر قرار می‌دهند.

  Refrence point)نقطه مرجع)رفرنس -

بر روی ماشــین‌ها ابزار CNC نقطه‌ای به نام نقطه 
مرجع ماشین یا مکان اولیه وجود داردکه توسط سازنده 
ماشین تعریف می‌شود و برای تنظیم و هماهنگ کردن 
سیســتم مکانیکی ماشین با سیســتم کنترل آن مورد 
استفاده قرار می‌گیرد. نقطه مرجع ماشین با حرف R و 

نماد مشخص می‌شود.

ماشــین CNC هرگاه که روشــن می‌شود(چه در 
ابتدای روز و چه پس از قطع برق( قادر به شناســایی موقعیت خود نمی‌باشــد و نیــاز به تنظیم دارد این کار را 

اصطلاحاً رفرنس کردن ماشین می‌گویند که به وسیله چند کلید انجام می‌شود.

  Tool refrence pointنقطه صفر ابزار-  

  این نقطه  در موقعیت خاص از ابزارگیر تعریف شده است و تصحیح و جبران شعاع طول 
و شعاع ابزار در راستای هریک از محورهای x،y و یا z نسبت به این نقطه محاسبه می‌شود.

نقطه صفر ابزار با حرف T و نماد  مشخص می‌شود.
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 Machine zero pointنقطه صفر ماشین  -  

 این نقطه توس��ط ش��رکت سازنده بر روی دستگاه تعریف می‌شود، قابلیت جابجایی نداشته و هنگامی ماشین 
روشن می‌شود دستگاه موقعیت خود را از این نقطه می‌شناسد.

نقطه صفر در ماش��ین‌های فرز معمولا در گوش��ه س��مت چپ و پایین میز تعریف می‌ش��ود و لازم است برای 
اطمینان از آن حتما به کتاب راهنمای ماش��ین مراجعه ش��ود که معمولا با علامت   یا حرف M مشخص 

می‌شود.

 Worlk part zero pointنقطه صفر فطعه کار  -  

این نقطه توس��ط برنامه نویس تعیین می‌شود و ماشین کاری از این نقطه شروع می‌شود معمولا برای قطعات 
مدور ، مرکز قطعه و برای قطعات مکعبی ش��کل ريا ،گوش��ه س��مت چپ و پایین قطعه کار به عنوان صفر در نظر 
گرفته می‌شود. که این نقطه با علامت   و حرف w  مشخص می‌شود. اگر برنامه‌نویس نقطه‌ای را مشخص 

نکند، ماشین‌کاری نسبت به صفر ماشین انجام می‌شود و این امر مشکلاتی را در بر خواهد داشت.
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اصول ایمنی

1- کار را با یاد خدا و با آرامش آغاز کنید و در هر حادثه خونسردی خود را حفظ کنید.

2- ش��ما با یک سیس��تم اتوماسیون کار می‌کنید و باید مراقب فرمان‌های خود باشید. در سیستم‌های دستی، 
مجری فرمان انسان است و شعور دارد. در واقع فرمان اشتباه را تشخیص می‌دهد ولی؛

   CNCفرمان بی کم و کاست اجرا می‌شود. دستگاه ، CNC در سیستم اتوماسیون شده و بالاخص در دستگاه 
یک پرسنل مطیع و بی رحم است .پیش بینی شوک‌های ناگهانی، هنگام تعمیر و تعویض قطعه و ابزار را بنمائید.

3- یکی از مش��کلات رایج در بین طراحان و اپراتورهای س��ی ان سی مشکلات ناشی از نشستن طولانی روی 
صندلی است دقت کنید، بیماری‌های فرسایشی ناشی از کار معمولا غیر قابل درمان هستند.

4-  اتفاقات مکانیکی بیش��تر مربوط به محور Z اس��ت. زیرا در شرایط بروز مشکل در این محور، جاذبه زمین 
موجب حرکت ناخواس��ته می‌شود و متاس��فانه با توجه به اینکه ابزار روی محور  Z است منجر به بروز خسارت و 

جراحت می‌گردد

بیشترین آمار بروز حوادث مربوط به افرادیست که غرور حرفه‌ای دارند. 	-5
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نحوه تعیین محورهای متعامد وچرخشی چگونه است؟ 	-1
کدام نقطه صفر توسط سازنده تعریف می‌شود؟ 	-2

رفرنس کردن دستگاه در چه مواقعی ضرورت دارد؟ 	-3
چند دستگاه CNC را نام برده وکاربرد هرکدام را توضیح دهید؟ 	-4

فن‌آوری NC  را توضیح دهید. 	-5
اجزای اصلی ماشین‌های CNC را نام برده و شرح دهید؟ 	-6
روش‌های ورود اطلاعات به ماشین CNC را شرح دهید؟ 	-7

نقاط صفر ماشین، قطعه کار و ابزار را تعریف نمایید؟ 	-8

آزمون پایانی



    واحد کار

ششم
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اهداف رفتاری:

پس از آموزش این واحد کار از فراگیر انتظار می‌رود که بتواند:

1. مراحل ماشین‌کاری یک قطعه را ترسیم نماید.

2. اختلاف سطوح را با استفاده از نمای قطعه مشخص کند.

3. ابزار مناسب جهت ماشین‌کاری را انتخاب نماید.

4. خطوط  با مسیر ماشین‌کاری را در هر مرحله ترسیم نماید.

5. جبران شعاع ابزار در ترسیم مراحل ماشین‌کاری را اعمال نماید.

6. حرکت ابزار بین سطوح مختلف را تشخیص داده و اعمال نماید.

هدف کلی : توانایی تعیین مراحل کار و انتخاب  ابزار مناسب جهت انجام کار

پیش آزمون: )20 دقیقه(

1- چگونه می‌توان مختصات یک نقشه را جابجا کرد؟

2- بهترین نقطه صفر قطعه کار چه مکانی می‌تواند باشد؟

3- یک قطعه کار را در چند مرحله کلی ماشین‌کاری می‌نمایند؟

4- بهترین دستور برای رسم خطوط ماشین‌کاری چه دستوری می‌باشد؟

5- جبران شعاع ابزار به چه طریق اعمال می‌شود؟
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مراحل ماشین‌کاری 
قبل از نوشتن برنامه یک قطعه لازم است مراحل ماشین‌کاری آن تهیه شده و به وسیله نرم افزار رسم گردد  برای 
این منظور در نرم افزار CAD هر مرحله را به صورت جداگانه ترس��یم کرده و س��طوح ماش��ین‌کاری را با هاشور 

مشخص می‌نماییم.

با توجه به شکل ساده زیر مشخص است که سطح طوسی رنگ بایستی از بلوک خام اولیه به عمق 10 میلی متر 
ماشین‌کاری شود.

در این تصویر مشخص است که اگر مرکز محور مختصات را وسط قطعه کار در نظر بگیریم سطح بالای قطعه کار )روی 
 قطعه کار ( دارای Z=0 می‌باشد و  ابزار بایستی بر روی این سطح مماس شود و مقدار Z آن بر روی دستگاه صفر شود.

-مرحله بعدی انتخاب ابزار مناس��ب برای ماش��ین‌کاری اس��ت، به طور اصولی یک قطعه کار در دو مرحله کلی 
ماشین‌کاری می‌شود.

1-خشن‌کاری

2-پرداخت

که ممکن است هرکدام از این مراحل در چند مرحله دیگر انجام شود بعنوان مثال خشن کاری یک قطعه کار در 
سه مرحله و با سه ابزار با قطرهای متفاوت انجام پذیرد. و یا مرحله پرداخت در 2 مرحله پیش پرداخت)به خاطر 

امکان پس زدگی ابزار( پرداخت انجام شود.

در مرحله خشن کاری قطعه کار به سایز نهایی نمی‌رسد و معمولا مقداری از دیوار و کف برای مراحل بعدی باقی 
می‌ماند این مقدار با توجه به موارد زیر تعیین می‌شود.



128

1- جنس قطعه کار :هر چه فلز نرم‌تر باشد مقدار ماده باقی مانده بیش‌تر است.

2- شکل قطعه کار : مراحل پیش پرداخت و پرداخت شکل‌های پیچیده دارای شیب و منحنی ،بیشتر می‌باشد.

3- دقت دستگاه و جنس ابزار.

4- تجربه برنامه نویس.

Stepover مقدار جابجایی ابزار -

مقدار جابجایی ابزار برای ماشین‌کاری یک قطعه کار بستگی به نوع ابزار دارد و بدین معنی است که ابزار بعد از 
طی یک مسیر مستقیم ماشین‌کاری چه مقدار جابجا شود.

مقدار جابجایی بستگی به نوع ابزار دارد که بشرح آن می پردازیم.

:Endmill) 1- ابزار های سرتخت )انگشتی

هنگام اس��تفاده از این ابزارها،کل قطر ابزار با کار  درگیر می‌باش��د و مقدار حداکثر براده‌برداری برابر با قطر ابزار 
است بنابراین برای ماشین‌کاری مسیرهای بعدی لازم است ابزار به اندازه قطر جابجا شود.

فرض شود مسیر ماشین‌کاری یک قطعه به صورت زیر است ابزار پس از طی مسیر  A لازم است مقداری جابجا 
شود که حداکثر این جابجایی برابر قطر ابزار می‌باشد.
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 CAM در این حالت ممکن است جای ابزار به صورت خطی بر روی قطعه کار باقی بماند معمولا در نرم افزارهای
و بطور کلی برای بدس��ت آوردن کیفیت س��طح بهتر اس��ت مقدار جابجایی را یک میلی متر از قطر ابزار کمتر در 

نظر می‌گیرند

Stepover=D-1

نکته: مقدار Stepover در خشن کاری و پرداخت تفاوتی ندارد فقط این مقدار به نوع ابزار 
و قطر ابزار بستگی دارد

)Tip Radius( 2- ابزارهای سرتخت شعاع دار

این ابزارها همانند شکل دارای کف تخت و گوشه‌های R دار می‌باشد و نوع الماسه خور آن نیز مورداستفاده قرار 
می‌گیرد که شعاع گوشه‌ها با توجه به شعاع الماسه مشخص می‌شود.
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همانطور که در ش��کل مش��خص است مقدار درگیری ابزار، کل قطر ابزار نمی‌باشد و فقط قسمت صاف آن درگیر 
می‌باشد که این قسمت برابر است با:

Stepover=D-2R

که R مقدار شعاع لبه ابزار می‌باشد در شکل بالا مقدار Stepover برابر است با :

D-2R=30-2(0/6)=28/8

که برای سهولت برنامه نویسی این مقدار را کمتر یعنی Steporer=28 در نظر می‌گیریم.
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ballnose 3- ابزارهای سرگرد

س��ر این ابزار ها گرد می‌باش��د و معمولا برای پرداخت س��طوح منحنی شکل و شیب دار استفاده می‌شود . مقدار 
جابجایی ابزار بس��تگی به کیفیت س��طح مورد نظر دارد و هر چه مقدار Stepover کمتر باشد کیفیت سطح در 

عملیات پرداخت )Finishing( بالاتر خواهد بود.

مسیر حرکت ابزار
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)Stepdown( مقدار باردهی-

مقدار بار دهی ابزار بستگی به موارد زیر دارد:

1- مرحله ماشین‌کاری )خشن کاری،پیش پرداخت،پرداخت(

2- جنس و فرم قطعه کار

3- جنس و فرم ابزار

البته لازم به ذکر است تجربه برنامه‌نویس و ماشین‌کار در تعیین مقدار بار تاثیر بسزایی دارد.

Toolpath تعیین مسیر ماشین‌کاری-

بطور کلی مسیر ماشین‌کاری به دو روش زیر تعیین می‌شود.

1-روشRaster : در این روش معمولا ابزار حرکت مس��تقیم دارد و به صورت رفت و برگش��تی ماشین‌کاری را 
انجام می‌دهد. در شکل زیر می‌خواهیم کل سطح قطعه کار را ماشین‌کاری نماییم.

1

2

34
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در این روش

1- حرکت ابزار به صورت منظم‌تری انجام می‌شود.

2- براده‌برداری به صورت موافق و مخالف انجام می‌شود.

3- مقدار جابجایی ابزار طبق Stepover تعیین می‌شود.

4- حرکت ابزار تابع مدل قطعه کار نمی‌باشد.

2-روش Offset : در این روش معمولا حرکت ابزار از شکل قطعه کار و پروفیل تبعیت می‌کند.

در ش��کل زیر جهت حرکت ابزار با فلش مش��خص ش��ده است و مس��یر ابزار Toolpath ،رنگ مشکی مشخص 
می‌شود و مقدار جابجایی ابزار Stepover برابر است با قطر ابزار نهایی:

Steporer=D-1

در شکل زیر می‌خواهیم کل سطح قطعه کار ماشین‌کاری نماییم.

در این روش :

1- حرکت ابزار تابعی از شکل قطعه کار است و معمولا حرکت منظمی ندارد.

2- زمان ماشین‌کاری در این روش نسبت به روش Raster کمتر است.

3

24

9

01

8

21

11 76

15
Tool ابزار
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3- حرکات اضافی ابزار نسبت به روش Raster بیش‌تر است.

4- مقدار Stepover  با توجه به جبران شعاع طبق محاسبات قبلی انجام می‌شود.

                    توجه:  در این روش تعیین مسیر حرکت ابزار)که در شکل باشماره مشخص شده(  بعهده برنامه 
نویس است که با توجه به شکل قطعه کار و نوع ماشین‌کاری)موافق ،مخالف یا ترکیبی( تعیین می‌گردد.

دستور کار1 :

مطلوبست تعیین مراحل‌کاری و برنامه نویسی شکل زیر

ابعاد بلوک خام   100×100 وارتفاع 25 میلی‌متر می‌باشد.

در این ترس��یم بایستی س��طح قرمز رنگ به عمق 10 میلی‌متر ماشین‌کاری ش��ود برای این قطعه مراحل زیر را 
انتخاب می‌نماییم. موارد زیر را تعیین می‌نمائیم.

1-ابزار انگشتی )Endmill( قطر 10

Raster 2-روش

Stepover=9 3-مقدار

Stepdown=0.5 4-مقدار

نقطه شروع

از سطح بلوک خام
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مس��یر حرکت ابزار را در نرم افزار CAD به وس��یله دس��تور Offset می‌توان ترس��یم کرد و با قرار دادن محور 
مختصات  در مرکز قطعه مختصات ابتدا و انتهای خطوط را بدست آورده و برنامه آن را می‌نویسیم.

N10   G0   X-50   Y-50   Z10                                     .ابتدا ابزار به بالای نقطه  شروع می‌رود -

      N20   G1   Z-0/5   F100    .وارد قطعه کار می‌شود Stepdown سپس به اندازه بار مورد نیاز -

                      

  N10   G1   X50   Y-50 .مختصات نقاط انتهای قطعه کار را داده و برنامه خط 1 را می‌نویسیم-

.به همین ترتیب برنامه خطوط 2 و 3 و ... تا انتها را می‌نویسیم                       

.  

.  

.  
- در انتها ابزار از قطعه کار خارج شده و مجدد به نقطه شروع می‌رود.   

N200    Z10
N210  G0   X-50   Y-50
N220   Z-1      
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- و به عمق ماشین‌کاری سطح دوم می‌رود.

به همین ترتیب ماشین‌کاری تا انتهای کار و اتمام قطعه انجام می‌شود.

   نکته:

تعیین مسیر و روش ماشین‌کاری  و  انتخاب ابزار به عهده برنامه نویس می‌باشد و لازم است به نکات زیر توجه نماید.

1-زمان ماشین‌کاری قطعه به حداقل برسد.

2- مقدار حرکات اضافی ابزار حذف شود.

3- جهت کاهش زمان ماشین‌کاری، از بزرگترین ابزار موجود ممکن استفاده شود.

4- برنامه نویس با توجه به شکل  می‌تواند برنامه را به صورت مطلق یا نسبی بنویسد.

دستور کار 2: 

برنامه ماشین‌کاری شکل زیر را بنویسید.

برای نوشتن برنامه‌ ماشین‌کاری مراحل زیر را بایستی مشخص نماییم.

1- تعیین بلوک ابعاد اولیه قطعه کار: ابعاد قطعه خام اولیه یک بلوک مس��تطیلی ش��کل بهاندازه 15×100×100  
می‌باشد.

2- انتخاب ابزار مناسب جهت ماشین‌کاری: ابزار Endmill به قطر 10
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3- تعیین مراحل ماش��ین‌کاری به کمک نرم افزارCAD الف ( ماش��ین‌کاری پیرامون قطعه کار ب( ماشین‌کاری 
حفره میانی 

4- تعیی��ن مق��دار بار)Stepdown( و مقدار جابجایی ابزار )Stepover( : که با توجه به جنس قطعه کار و ابزار 
تعیین می‌گردد.

 offset یا raster 5- تعیین ترسیم مسیر حرکت ابزار : روش

6- پیدا کردن مختصات ماشینکاری:

7- نوشتن برنامه 

بعد از تعیین مراحل 1 و 2 لازم است مراحل ماشین‌کاری با توجه به نرم افزار موجود طراحی و ترسیم شود

1- ترس��یم مرحله اول ماش��ین‌کاری : اگر محور مختصات را روی کار ودر مرکز قطعه کار در نظر بگیریم عمق 
ماشین‌کاری ناحیه رنگی 10 میلی متر می‌باشد.
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 2- ترسیم سطح دوم ماشین‌کاری 

تعیین مسیر حرکت ابزار Toolpaths مرحله اول به دو روش زیر 

Raster تعیین مرحله اول ماشین‌کاری روش

با توجه به قطر ابزار تعیین شده مسیر حرکت ابزار را در نرم افزار AutoCAD به کمک دستورات ترسیمی مثل 
Offset ترسیم می نماییم . که بایستی توجه داشته باشیم .

Go ابتدا ابزار بالای نقطه شروع قرار گیرد با حرکت -

Go با حرکت ) Stepdown ابزار به عمق مورد نظر رفته ) مقدار بار در مرحله اول -

- بعد از ترسیم مسیر حرکت محور مختصات را با استفاده از Ucslcon به نقطه مورد نظر انتقال دهیم.

- مختصات نقاط انتهای مسیر ابزار را با استفاده از نرم افزار استخراج نماییم 

- مسیر حرکت ابزار را از ابتدا تا انتها مشخص نماییم 

- با استفاده  از کدهای حرکتی G1 و Go و غیره برنامه ماشینکاری سطح اول را بنویسیم.
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- ابزار را به عمق بعدی با کد G1 انتقال دهیم 

- مسیر حرکت ماشین کاری سطح دوم را بنویسیم

                        

                توجه: 

بعد از ترسیم خطوط ماشین‌کاری بر روی قطعه وبا رنگی متفاوت محور ماشین‌کاری استخراج کرده و برنامه آنرا 
می‌نویسم لازم به ذکر است تعیین

- خطوط قرمز رنگ مسیر حرکت ابزار 

Go خطوط قرمز رنگ خط چین حرکت بدون براده برداری ابزار -

 همانطور که مشخص است منطقه ماشین‌کاری شده در دو مرحله انجام شده است.

شروع ماشین کاری
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 ابزار
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Offset تعیین مرحله اول ماشین‌کاری به روش -

- مرحله اول ماشــین‌کاری را به روش دیگری نیز می تــوان انجام داد بدین ترتیب که ابزار بزرگ‌تری را انتخاب 
نماییم  مثلاً ابزار Endmill  فقط 15 میلی متر و مسیر ابزار را به صورت شکل زیر در نرم افزار CAD ترسیم 
نماییم ملاحظه می نمایید که دراین حالت برنامه ماشــین‌کاری کوتاه‌تر شده و زمان کمتری صرف ماشین‌کاری 

قطعه می‌شود.

                          نکته:

 برای تعیین مســیر ماشین‌کاری کافیست مربع داخلی شکل را به اندازه شعاع ابزار offset نماییم اگر کل سطح 
ماشین‌کاری پوشش داده نشود مجدد خطوط را به اندازه Steporer و Offset نماییم.

مسیر ماشین کاری
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2- تعیین مرحله دوم ماشین‌کاری 

 R5 همانطور که مش��خص کردیم ناحیه داخلی بایس��تی در مرحله دوم ماشین‌کاری شود با توجه شعاع گوشه‌ها
از ابزار قطر 10 استفاده می‌نماییم تا علاوه بر کوتاه شدن مسیر ماشین‌کاری گوشه‌های قطعه کار با حرکت ابزار 

ایجاد گردد.
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دراین مرحله ابزار مس��یر دایروی و چهارگوش را طی کرده تا حفره در پاس اول خالی ش��ود سپس بهمین ترتیب 
به عمق بعدی رفته و عملیات ماشین‌کاری را تکمیل می ‌نماید.

لازم ب��ه ذکر اس��ت در این برنامه مقدار ب��ارStepdown را 5 میلی متر در نظر گرفته‌ای��م که این مقدار جهت 
ماشین‌کاری عملی زیاد می‌باشد و بایستی مقدار Stepdown با توجه به جنس قطعه کار جنس ابزار و توانایی 

ماشین‌کاری دستگاه تعیین گردد.

شکل کلی مسیر ماشین‌کاری به صورت زیر است

دستور کار 3

برنامه ماشین‌کاری شکل زیر را بنویسید.
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1- تعیین بلوک ابعاد اولیه قطعه کار: ابعاد قطعه خام اولیه یک بلوک مس��تطیلی ش��کل بهاندازه 15×100×100  
می‌باشد.

2- انتخاب ابزار مناسب جهت ماشین‌کاری: ابزار Endmiu به قطر 10

3- تعیین مراحل ماش��ین‌کاری به کمک نرم افزارCAD الف ( ماش��ین‌کاری پیرامون قطعه کار ب( ماشین‌کاری 
حفره میانی 

4- تعیی��ن مق��دار بار)Stepdown( و مقدار جابجایی ابزار )Stepover( : که با توجه به جنس قطعه کار و ابزار 
تعیین می‌گردد.

 Offset یا Raster 5- تعیین ترسیم مسیر حرکت ابزار : روش

6- پیدا کردن مختصات ماشینکاری:

7- نوشتن برنامه 

CADتعیین مراحل ماشین‌کاری به کمک نرم افزار -

بعد از تعیین مراحل 1 و 2 لازم است مراحل ماشین‌کاری با توجه به نرم‌افزارهای موجود طراحی و ترسیم کنیم

1- ترس��یم مرحله اول ماش��ین‌کاری: اگر محور مختصات را روی کار و در مرکز قطعه کار در نظر بگیریم عمق 
ماشین‌کاری ناحیه رنگی 20 میلی متر می‌باشد.
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2- ترسیم مرحله دوم ماشین‌کاری 

3- مرحله سوم ماشین‌کاری 

4- مرحله چهارم ماشین‌کاری 
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5- مرحله آخر ماشین‌کاری 

تعیین مسیر حرکت ابزار 

1- مرحله سوم ماشین‌کاری 

2- مرحله چهارم ماشین‌کاری 

3- مرحله آخر ماشین‌کاری 

مرحله اول ماشین‌کاری 
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مرحله ب مرحله دوم ماشین‌کاری 

در این مرحله کافیست با چند حرکت قدسی شکل قسمت مورد نظر را ماشین‌کاری نماییم 

- مرحله سوم ماشین‌کاری 
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- مرحله چهارم ماشین‌کاری 
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مرحله آخر 

در این مرحله کافیست با یک حرکت خطی چهارگوش حفره نمایی ماشین‌کاری شود.
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1- ش��کل‌های زیر را در نرم افزارAuto CAD رسم کرده و بعد از ترسیم مراحل ومسیر ماشین‌کاری 
برنامه آنرا بنویسید.

آزمون پایانی
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